**MatrikonOPC Server for Simulation**

**User's Manual**

This manual is a product of Matrikon Inc.

Matrikon Inc.
Suite 1800, 10405 Jasper Avenue
Edmonton, AB T5J 3N4
Canada

Phone: 780.448.1010
Fax: 780.448.9191
www.matrikonopc.com

**Document Revision History:**

<table>
<thead>
<tr>
<th>Date</th>
<th>Document Version</th>
<th>Description</th>
<th>Author</th>
</tr>
</thead>
<tbody>
<tr>
<td>2003-08-19</td>
<td>1.0</td>
<td>Initial document.</td>
<td>DENG</td>
</tr>
<tr>
<td>2004-04-02</td>
<td>1.1</td>
<td>Added HDA and AE functionality descriptions.</td>
<td>IMF</td>
</tr>
<tr>
<td>2008-05-14</td>
<td>2.0</td>
<td>Converted to new template.</td>
<td>LB</td>
</tr>
<tr>
<td>2008-08-25</td>
<td>2.1</td>
<td>Added OPC item descriptions, updated Installed Files, updated Installation and Un-Installation sections, updated Troubleshooting section.</td>
<td>RK, LB</td>
</tr>
<tr>
<td>2009-07-17</td>
<td>3.0</td>
<td>MatrikonOPC Server Framework v1.11.1.0/1.7.0.0 applied to server. Software version updated to 1.5.0.0. Updated Installation section. Updated Contacting Support section. Alias Configuration section updated to include Calculation scaling and Item Browser information. Limitations section updated. Appendix B – Aliases: added Scaling Calculation section, updated CSV File Format and Scaling Algorithms sections. Updated Appendix E – Security.</td>
<td>LB</td>
</tr>
</tbody>
</table>
# Table of Contents

**Introduction** .......................................................................................................................... 9  
Who Should Use This Manual ................................................................................................. 9  
Overview of Manual ................................................................................................................ 10  
References ............................................................................................................................... 10  
Terminology ............................................................................................................................. 10

**Getting Started** .................................................................................................................. 12  
System Requirements ............................................................................................................. 12  
Software Requirements .......................................................................................................... 12  
Hardware Requirements ......................................................................................................... 12  
Installation .............................................................................................................................. 12  
Installed Files .......................................................................................................................... 21  
Licensing ................................................................................................................................. 23  
Contacting Support .................................................................................................................. 23

**Configuration** ...................................................................................................................... 25  
Configuring Dynamic Data Exchange (DDE) ......................................................................... 25  
Starting the MatrikonOPC Server for Simulation .................................................................... 26  
Tool Tray Menu ....................................................................................................................... 26  
Control Panel .......................................................................................................................... 26  
Configuration Window ............................................................................................................ 27  
  File Menu .............................................................................................................................. 29  
  Edit Menu ............................................................................................................................. 29  
  View Menu ........................................................................................................................... 30  
  Tools Menu .......................................................................................................................... 30  
  Help Menu ........................................................................................................................... 31  
Options Window ...................................................................................................................... 31  
  General Options .................................................................................................................. 31  
  General Logging Options ................................................................................................. 33  
  Interface Logging Options ............................................................................................... 34  
  Advanced Options ............................................................................................................ 36

Server Configuration .................................................................................................................. 37  
Alias Configuration ................................................................................................................... 37  
  Inserting Alias Groups ...................................................................................................... 37  
  Renaming Alias Groups .................................................................................................... 37  
  Inserting New Aliases ....................................................................................................... 37  
  Editing Aliases ................................................................................................................... 41  
  Removing Aliases .............................................................................................................. 41  
  Removing Alias Groups .................................................................................................. 41  
  Exporting Aliases ............................................................................................................. 41  
  Importing Aliases ............................................................................................................. 42  
Expression Wizard .................................................................................................................... 42  
Item Path Browser .................................................................................................................... 46  
Saving a Configuration .......................................................................................................... 48  
Clearing a Configuration ......................................................................................................... 48  
Loading an Existing Configuration ......................................................................................... 48

Shutting Down the Server ........................................................................................................ 49

**OPC Data Items** ..................................................................................................................... 50  
Simulation Items ....................................................................................................................... 50  
  Available Items .................................................................................................................. 50  
  Dynamic Item Creation ..................................................................................................... 50

**Diagnostics** ........................................................................................................................... 52
# Table of Contents

## Logging ................................................................. 52
## Limitations ................................................................ 53
## Troubleshooting ...................................................... 54
  Problems and Solutions ............................................. 54
## Un-Installation ......................................................... 62
## OPC Compliance ....................................................... 67
  Installation ............................................................... 67
  Common Interfaces .................................................. 67
  Data Access .................................................................. 67
    Groups ....................................................................... 68
    Items ......................................................................... 68
  Browsing and Item Properties ..................................... 68
  I/O Operations ............................................................ 68
## Alarms and Events Functionality .............................. 69
  Simulated Event ....................................................... 70
  Simulated Item Creation Event ................................... 70
## Historical Data Access Functionality ...................... 70
  Read Functionality .................................................... 71
  Update Functionality .................................................. 72
  MatrikonOPC Server for Simulation Functionality .......... 72

## Table of Appendices

### Appendix A – Distributed COM (DCOM) ....................... 74
  DCOM Configuration Utility ...................................... 74
  Default Properties .................................................... 74
  Security Permissions .................................................. 75
  Server Identity .......................................................... 78
  Default Protocols ....................................................... 78
  Remote Program ID ..................................................... 79
### Appendix B – Aliases ................................................... 80
  Scaling Expressions .................................................... 80
  Scaling Calculations ................................................... 81
  CSV File Format .......................................................... 84
  Scaling Algorithms ...................................................... 85
### Appendix C – Standard Data Types ......................... 86
### Appendix D – Microsoft Excel as a DDE Client .......... 87
  DDE Read ................................................................. 87
  DDE Write .................................................................. 87
  Net DDE .................................................................... 88
### Appendix E – Security ................................................. 89
  Introduction ............................................................... 89
  OPC Security Implementation .................................... 89
  MatrikonOPC Tag Security Configuration Utility .......... 90
  Security Details ........................................................ 112
## Table of Figures

<table>
<thead>
<tr>
<th>Figure</th>
<th>Description</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>InstallAware Wizard Verification Window</td>
<td>13</td>
</tr>
<tr>
<td>2</td>
<td>License Agreement Screen</td>
<td>14</td>
</tr>
<tr>
<td>3</td>
<td>Setup Type Screen</td>
<td>15</td>
</tr>
<tr>
<td>4</td>
<td>Destination Folder Screen</td>
<td>16</td>
</tr>
<tr>
<td>5</td>
<td>Start Menu Screen</td>
<td>17</td>
</tr>
<tr>
<td>6</td>
<td>Enter Password Screen</td>
<td>18</td>
</tr>
<tr>
<td>7</td>
<td>Ready to Install Screen</td>
<td>19</td>
</tr>
<tr>
<td>8</td>
<td>Installing MatrikonOPC Server for Simulation Screen</td>
<td>20</td>
</tr>
<tr>
<td>9</td>
<td>MatrikonOPC Server for Simulation Setup Complete Screen</td>
<td>21</td>
</tr>
<tr>
<td>10</td>
<td>Tool Tray</td>
<td>26</td>
</tr>
<tr>
<td>11</td>
<td>Tool Tray Menu</td>
<td>26</td>
</tr>
<tr>
<td>12</td>
<td>Control Panel</td>
<td>27</td>
</tr>
<tr>
<td>13</td>
<td>Configuration Window</td>
<td>28</td>
</tr>
<tr>
<td>14</td>
<td>General Options Tab</td>
<td>32</td>
</tr>
<tr>
<td>15</td>
<td>General Logging Options Tab</td>
<td>33</td>
</tr>
<tr>
<td>16</td>
<td>Interface Logging Options Tab</td>
<td>35</td>
</tr>
<tr>
<td>17</td>
<td>Advanced Options Tab</td>
<td>36</td>
</tr>
<tr>
<td>18</td>
<td>Insert New Alias Window</td>
<td>38</td>
</tr>
<tr>
<td>19</td>
<td>Insert New Alias Window Scaling Options</td>
<td>39</td>
</tr>
<tr>
<td>20</td>
<td>- Contents Table</td>
<td>40</td>
</tr>
<tr>
<td>21</td>
<td>Expression Tab</td>
<td>43</td>
</tr>
<tr>
<td>22</td>
<td>Expression Wizard</td>
<td>44</td>
</tr>
<tr>
<td>23</td>
<td>Select Function Window</td>
<td>44</td>
</tr>
<tr>
<td>24</td>
<td>Select Variable Window</td>
<td>45</td>
</tr>
<tr>
<td>25</td>
<td>User Defined Functions Editor</td>
<td>45</td>
</tr>
<tr>
<td>26</td>
<td>Operators Buttons</td>
<td>46</td>
</tr>
<tr>
<td>27</td>
<td>- Calculation Tab</td>
<td>47</td>
</tr>
<tr>
<td>28</td>
<td>Item Path Browser</td>
<td>47</td>
</tr>
<tr>
<td>29</td>
<td>Registry Editor</td>
<td>55</td>
</tr>
<tr>
<td>30</td>
<td>Program ID Branch</td>
<td>56</td>
</tr>
<tr>
<td>31</td>
<td>Add/Remove Programs</td>
<td>62</td>
</tr>
<tr>
<td>32</td>
<td>Welcome to MatrikonOPC Server for Simulation Maintenance Screen</td>
<td>63</td>
</tr>
<tr>
<td>33</td>
<td>Ready to Uninstall Window</td>
<td>64</td>
</tr>
<tr>
<td>34</td>
<td>Uninstalling MatrikonOPC Server for Simulation Screen</td>
<td>65</td>
</tr>
<tr>
<td>35</td>
<td>MatrikonOPC Server for Simulation Setup Complete</td>
<td>66</td>
</tr>
<tr>
<td>36</td>
<td>Distributed COM Configuration Properties Window</td>
<td>75</td>
</tr>
<tr>
<td>37</td>
<td>Distributed COM Configuration Security Tab</td>
<td>76</td>
</tr>
<tr>
<td>38</td>
<td>Registry Value Permissions Window</td>
<td>77</td>
</tr>
<tr>
<td>39</td>
<td>Add Users and Groups Window</td>
<td>77</td>
</tr>
<tr>
<td>40</td>
<td>DDE Share</td>
<td>88</td>
</tr>
<tr>
<td>41</td>
<td>Start Menu Navigation</td>
<td>91</td>
</tr>
<tr>
<td>42</td>
<td>Enter Server Password Window</td>
<td>91</td>
</tr>
<tr>
<td>43</td>
<td>MatrikonOPC Tag Security Configuration Utility Main Screen</td>
<td>92</td>
</tr>
<tr>
<td>44</td>
<td>MatrikonOPC Tag Security Configuration Utility Main Screen: Users &amp; Groups</td>
<td>93</td>
</tr>
<tr>
<td>45</td>
<td>Add User Window (NT)</td>
<td>94</td>
</tr>
<tr>
<td>46</td>
<td>Defined Users and Groups</td>
<td>95</td>
</tr>
<tr>
<td>47</td>
<td>Add User Window (Private)</td>
<td>96</td>
</tr>
<tr>
<td>48</td>
<td>Add Group Window (NT)</td>
<td>97</td>
</tr>
<tr>
<td>49</td>
<td>Add Group Window (Private)</td>
<td>98</td>
</tr>
</tbody>
</table>
Table of Tables

Table 1 - Data Options...................................................................................................... 9
Table 2 - Terms and Definitions...................................................................................... 11
Table 3 - Files Installed in "Simulation" Folder .............................................................. 22
Table 4 - Files Installed in "Common" Folder .................................................................. 23
Table 5 - Files Installed in "system32" Folder ................................................................ 23
Table 6 - MatrikonOPC Support Regional Contact Information ................................... 24
Table 7 - After-Hours Support ......................................................................................... 24
Table 8 - Tool Tray Menu Commands ............................................................................ 26
Table 9 - Control Panel Commands ............................................................................... 27
Table 10 - Configuration Window Commands ............................................................ 29
Table 11 - File Menu Commands .................................................................................... 29
Table 12 - Edit Menu Commands (Server Configuration) .............................................. 30
Table 13 - Edit Menu Commands (Alias Configuration) ................................................ 30
Table 14 - View Menu Commands .................................................................................. 30
Table 15 - Tools Menu Commands .................................................................................. 31
Table 16 - Help Menu Commands ................................................................................... 31
Table 17 - General Options Tab Fields ............................................................................ 33
Table 18 - General Logging Options Tab Fields ............................................................ 34
Table 19 - Interface Logging Options Tab Fields ............................................................ 35
Table 20 - Advanced Options Tab Fields ........................................................................ 37
Table 21 - Insert New Alias Window Options ............................................................... 38
Table 22 - Insert New Alias Window Scaling Options .................................................. 39
Table 23 - Expression Wizard Options ............................................................................ 42
Table 24 - Item Path Browser Options ............................................................................ 46
Table 25 - Available Items .............................................................................................. 50
Table 26 - Simulated Event - Event Notification Attributes ........................................... 70
Table 27 - Simulated Item Creation Event - Event Notification Attributes ................... 70
Table 28 - Simulated Item Types Supported Operations ................................................ 71
Table 29 - Aggregation Functions Supported by Simulation Server ............................... 71
Table 30 - Attributes Stored for Each Item by Simulation Server ................................ 72
Table 31 - OPC Alarms and Events Custom Interface Standard v1.10 Events ............... 72
Table 32 - OPC Historical Data Access Custom Interface Standard v1.20 Read Functions ........................................................................................................................................ 73
Table 33 - OPC Historical Data Access Custom Interface Standard v1.20 Update Functions .......................................................................................................................... 73
Table 34 - OPC Historical Data Access Custom Interface Standard v1.20 Annotation Functions .................................................................................................................................................................................. 73
Table 35 - OPC Historical Data Access Custom Interface Standard v1.20 Playback Functions .................................................................................................................................................................................. 73
Table 36 - Expressions Constructs for Alias Scaling .................................................................................................................................................................................. 81
Table 37 - Calculation Operators for Alias Scaling .................................................................................................................................................................................. 82
Table 38 - Calculation Functions for Alias Scaling .................................................................................................................................................................................. 83
Table 39 - File Import/Export Field Descriptions .................................................................................................................................................................................. 84
Table 40 - Additional File Import/Export Field Descriptions – Linear/Square Root Scaling .................................................................................................................................................................................. 85
Table 41 - Additional File Import/Export Field Descriptions - Offset Scaling .................................................................................................................................................................................. 85
Table 42 - Additional File Import/Export Field Descriptions - Expression Scaling .................................................................................................................................................................................. 85
Table 43 - Additional File Import/Export Field Descriptions - Calculation Scaling .................................................................................................................................................................................. 85
Table 44 - Scaling Algorithms .......................................................................................................................................................................................... 85
Table 45 - Standard Data Types .......................................................................................................................................................................................... 86
Table 46 - Default Tag Security .......................................................................................................................................................................................... 110
Table 47 - Example 1 .......................................................................................................................................................................................... 111
Table 48 - Example 2: Permissions .......................................................................................................................................................................................... 111
Table 49 - Example 2: Groups and Members .......................................................................................................................................................................................... 111
Table 50 - Example 2: Permissions .......................................................................................................................................................................................... 114
Introduction

The MatrikonOPC™ Server for Simulation (also referred to as MatrikonOPC Server for Simulation and Testing or Simulation server) enables data interchange to any OPC clients. The server provides different types of data that offers testing abilities.

Table 1 lists the various data options available in the server.

<table>
<thead>
<tr>
<th>Source Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Brigade</td>
<td>Provides variables that can be set to any value depending on their type. Read and Write capabilities.</td>
</tr>
<tr>
<td>Random</td>
<td>Produces random values to test Read capabilities of an OPC client.</td>
</tr>
<tr>
<td>Read Error</td>
<td>Allows testing on OPC client’s behaviour when an error occurs.</td>
</tr>
<tr>
<td>Waves</td>
<td>Produces read-only values in a Square, Saw-tooth, or Triangle wave.</td>
</tr>
<tr>
<td>Write Errors</td>
<td>Allows test for Write errors.</td>
</tr>
<tr>
<td>Write Only</td>
<td>Allow Write tests.</td>
</tr>
</tbody>
</table>

Table 1 - Data Options

The MatrikonOPC Server for Simulation can be used to simulate other OPC servers on a simple level, and to test your OPC client or architecture. This server can give users a useful source of data to test their system. Not only does it come pre-loaded with data points that perform multiple functions, but you can also add more simulated tags as needed.

The Simulation server can also be used to troubleshoot system connectivity by replacing your OPC server with the Simulation server which can then expose OPC server configuration issues.

Who Should Use This Manual

This manual is intended for all users of MatrikonOPC Server for Simulation. This manual explains how to install, license, and configure the software, and how to perform common tasks. In addition and where required, technical information about OPC data items, diagnostics information, and a troubleshooting section is included.

Overview of Manual

This manual uses icons to highlight valuable information. Remember these icons and what they mean, as they will assist you throughout the manual.

- !: This symbol denotes important information that must be acknowledged. Failure to do so may result in the software not functioning properly.
- BOLD: Font displayed in this color and style indicates a hyperlink to the applicable/associated information within this manual, or if applicable, any external sources.

The User’s Manual has been designed so that you can click on references in the document to jump to that referenced point without having to scroll through several pages (in some cases). For example, if you were to see the sentence “Refer to Figure 1 for more information”, pressing the
CTRL key and clicking your mouse on the text “Figure 1” will automatically take you to the location of Figure 1 within the document.

This manual consists of several chapters and is structured as follows:

- **Introduction** – this introductory chapter.
- **Getting Started** – provides instructions for installing the software, and MatrikonOPC Support team contact information.
- **Configuration** – shows how to start and configure the server, and describes each component in detail including windows/screens, panels-tabs, and menu commands.
- **OPC Data Items** – describes the server’s items.
- **Diagnostics** – explains how to use logging, statistical items, data qualities and timestamps, and result codes to get the most efficiency from the user’s system.
- **Limitations** – provides information on specific performance and operational limitations of the software (if any).
- **Troubleshooting** – provides solutions for common problems that may be encountered, and answers to frequently asked questions.
- **Un-installation** – provides instructions on un-installing the software.
- **OPC Compliance** – details supported interfaces with regard to installation, common interfaces, and data access.
- **Appendices:**
  - A - DCOM
  - B - Aliases
  - C - Standard Data Types
  - D - Microsoft Excel as a DDE Client
  - E - Security

**References**

This document references information found within the following documents/sites:

- [www.opcfoundation.org](http://www.opcfoundation.org)
- [www.matrikonopc.com](http://www.matrikonopc.com)
- [www.opcsupport.com](http://www.opcsupport.com)
- **OPC Overview 1.0**
- **OPC Common Definitions and Interfaces 1.0**
- **OPC Historical Data Access Custom Interface Standard 1.20**
- **OPC Data Access Custom Interface Standard 2.05**
- **OPC Data Access Custom Interface Standard 3.00**
- **OPC Alarms and Events Custom Interface Standard 1.10**

**Terminology**

The following terms are used interchangeably throughout this document:
- screen and window
- tab and panel
- MatrikonOPC Server for Simulation and Simulation server and MatrikonOPC Server for Simulation and Testing

Table 2 provides a list of definitions for terms used throughout this document.

<table>
<thead>
<tr>
<th>Term/Abbreviation</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>COM</td>
<td>Component Object Model. A method for organizing software, specifying how to build components that can be dynamically interchanged.</td>
</tr>
<tr>
<td>DA</td>
<td>OPC Data Access. Provides access to real-time process data.</td>
</tr>
<tr>
<td>DCOM</td>
<td>Distributed Component Object Model. An extension of COM that allows communication between COM components over a network.</td>
</tr>
<tr>
<td>DDE</td>
<td>Dynamic Data Exchange. Allows the transfer of data between two running applications.</td>
</tr>
<tr>
<td>DDL</td>
<td>Data Definition Language.</td>
</tr>
<tr>
<td>HDA</td>
<td>OPC Historical Data Access.</td>
</tr>
<tr>
<td>HMI</td>
<td>Human Machine Interface. Device that allows interaction between the user and machine. Typically used in process control applications.</td>
</tr>
<tr>
<td>LAN</td>
<td>Local Area Network.</td>
</tr>
<tr>
<td>Matrikon</td>
<td>Matrikon Inc.</td>
</tr>
<tr>
<td>MatrikonOPC</td>
<td>Matrikon’s brand name for its OPC servers and clients.</td>
</tr>
<tr>
<td>OPC</td>
<td>The communication standards published by the OPC Foundation. Refer to <a href="http://www.opcfoundation.org">www.opcfoundation.org</a> for more information.</td>
</tr>
<tr>
<td>PLC</td>
<td>Programmable Logic Controller.</td>
</tr>
<tr>
<td>Sync/Async</td>
<td>Abbreviations for Synchronous and Asynchronous operations.</td>
</tr>
</tbody>
</table>

*Table 2 - Terms and Definitions*
Getting Started
This section of the User’s Manual contains important information regarding software installation and how to contact MatrikonOPC’s Support team.

The System Requirements section shows how to avoid future problems by ensuring that the system meets the minimum software and hardware requirements. Detailed, step-by-step instructions in the Installation section will guide you through the installation process and provide a list of files that are installed during this process.

Once the software is installed, refer to the Licensing section for information on how to obtain the appropriate license. The Licensing section will refer you to the Licensing Procedures document that was installed along with the server and this User’s Manual. The Contacting Support section will provide you with contact information for the MatrikonOPC Support team, should you have any problems during the installation or licensing of the software.

System Requirements
The software has Software and Hardware system requirements. These requirements must be met for the software to function properly.

Note: To install and configure a MatrikonOPC server, you must be set up as an administrative user account rather than a restricted user account.

Software Requirements
The following software is required:

• Microsoft Windows XP, or
• Microsoft Windows 2003, or
• Microsoft Windows 2000

Note: It is recommended that the most current service packs are installed.

Hardware Requirements
The following hardware is required:

• Intel® Pentium® 4 Processor
• 512 MB RAM
• 40 GB 7200 RPM Hard Drive

Installation
Once the system requirements have been met, you are ready to install the software.
Notes:

- Prior to starting the installation process, it is recommended that you make sure that the Data Execution Prevention (DEP) is set to *Turn on DEP for essential Windows programs and services only*. If not, you will need to re-install the product. DEP does not affect all operating systems (i.e., DEP is used in XP SP2 and 2003 SP1).
- As part of the installation process, the **MatrikonOPC Analyzer** tool is installed and used to detect the system settings that affect the use of this software. No information is communicated back to Matrikon. Information is stored on this system **only** for future use by MatrikonOPC Support to assist with troubleshooting, if required.

To install the software:

1. Insert the MatrikonOPC Server for Simulation CD into the CD drive.
2. If the MatrikonOPC Welcome screen does not automatically appear, double-click the *MatrikonOPCSimulation.exe* file. The **MatrikonOPC Server for Simulation – InstallAware Wizard** verifies its contents (Figure 1), and the **License Agreement** screen (Figure 2) appears.

Notes:

- The **Version** number located in the lower left corner indicates the version number of the software that is being installed. The text “X.X.X.X” will be replaced with the specific product version.
- From the **License Agreement** screen, you also have the option of selecting or rejecting the license agreement. Selecting the *I reject the license agreement* option disables the **Next** button so your options are to return to the previous screen, cancel the install by clicking on the **Cancel** button, or select the *I accept the license agreement* option enabling you to continue through the install.

![Figure 1 - InstallAware Wizard Verification Window](image-url)
3. Read the **Software License Agreement**, using the scroll bar to view the entire message.

4. Select the **I accept the license agreement** option.

5. Click on the **Next** button. The **Setup Type** screen (Figure 3) appears.

   **Note:** From this point onward, the **Back** button is available allowing you to return to the previous screen or screens.
6. Select the type of setup to be performed

   **Note:** Matrikon recommends that you select the **Complete Setup** option.

7. Click on the **Next** button. The **Destination Folder** screen (Figure 4) appears.
8. Select the folder in which to install the MatrikonOPC Server for Simulation.  

   **Note:** By default, the `C:\Program Files\Matrikon\OPC` folder is selected.

9. Click on the **Next** button. The **Start Menu** screen (Figure 5) appears.
10. Select the **Start Menu** group and specify whether you want shortcuts created only for yourself, or for all users, by selecting the applicable option.

11. Click on the **Next** button. The **Enter Password** screen (Figure 6) appears.
12. A default password is supplied for you in the **Password** and **Confirm Password** fields.

**Notes:**

- The default password provided for you is **MatrikonOPC**. Note this password for future reference.
- If you need to change the password at a later date, access the **Tag Security** shortcut from the **Start** menu. Click on the Windows **Start** button. Select **Programs** -> **MatrikonOPC** -> **<OPC Server Name>** -> **Tag Security**. For more information, refer to **Appendix E – Security**.

13. Click on the **Next** button. The **Ready to Install** screen (Figure 7) appears.
14. Click on the **Next** button. The **Installation MatrikonOPC Server for Simulation** screen (Figure 8) appears, installation begins, and the server files are copied to the computer.

**Note:** Prior to starting the installation, you have the option of clicking on the **Back** button to change any of the installation information. Click on the **Cancel** button if you wish to stop or cancel the installation.
15. When the installation has finished, the **MatrikonOPC Server for Simulation Setup Complete** screen (Figure 9) appears stating that MatrikonOPC Server for Simulation has been successfully installed.
16. At this point, you have the option of selecting the applicable checkboxes and launching any or all of the following:

- *MatrikonOPC Server for Simulation User’s Manual*
- *MatrikonOPC Server for Simulation Release Notes*
- Simulation Configuration Video

17. Click on the **Finish** button to complete the installation and exit the Wizard.

18. The necessary files have now been copied to the target computer, the software components registered, and shortcut icons created in the **Start** menu.

**Note:** At this point, it is recommended that you verify the DCOM settings. Reference to the DCOM configuration can be found in the **DCOM Manual**, This configuration varies for different operating systems.

**Installed Files**

The installation program copies all necessary files to the target computer and creates shortcut icons in the **Start** menu.
The files listed in Table 3 are installed by default, in the following location:

**C:\Program Files\Matrikon\OPC\Simulation**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plugins</td>
<td></td>
</tr>
<tr>
<td>ACL.sec</td>
<td>Access control list containing users and permissions configured for the server.</td>
</tr>
<tr>
<td>ACLSecure.exe</td>
<td>Command-line security utility used to encrypt/decrypt the ACL file.</td>
</tr>
<tr>
<td>AliasCalculationLib.dll</td>
<td></td>
</tr>
<tr>
<td>Altova.dll</td>
<td></td>
</tr>
<tr>
<td>AltovaXML.dll</td>
<td></td>
</tr>
<tr>
<td>CalcEngine_u.dll</td>
<td></td>
</tr>
<tr>
<td>CalcEngineResource.dll</td>
<td></td>
</tr>
<tr>
<td>CalculationGraph.dll</td>
<td></td>
</tr>
<tr>
<td>clipsdll.dll</td>
<td></td>
</tr>
<tr>
<td>icudt36.dll</td>
<td></td>
</tr>
<tr>
<td>icuin36.dll</td>
<td></td>
</tr>
<tr>
<td>icuuc36.dll</td>
<td></td>
</tr>
<tr>
<td>js32.dll</td>
<td>Calculation Engine binary files.</td>
</tr>
<tr>
<td>log4cxx.dll</td>
<td></td>
</tr>
<tr>
<td>NTEventLogAppender.dll</td>
<td></td>
</tr>
<tr>
<td>OpcDataDelivery_u.dll</td>
<td></td>
</tr>
<tr>
<td>ProcessNetDataDelivery_u.dll</td>
<td></td>
</tr>
<tr>
<td>Scheduler_u.dll</td>
<td></td>
</tr>
<tr>
<td>ScriptLibrary_u.dll</td>
<td></td>
</tr>
<tr>
<td>Xerces-c_2_7.dll</td>
<td></td>
</tr>
<tr>
<td>OPCSIm.exe</td>
<td>Server executable.</td>
</tr>
<tr>
<td>ProgId.txt</td>
<td>Product identification file used by ACLSecure.exe.</td>
</tr>
<tr>
<td>Project Info.log</td>
<td>Product dependency file.</td>
</tr>
<tr>
<td>security.cfg</td>
<td>Security settings.</td>
</tr>
<tr>
<td>ServerOpts.ini</td>
<td>Server configuration file.</td>
</tr>
<tr>
<td>Simulation.wmv</td>
<td>Instructional video providing instructions on how to install and use the Simulation server.</td>
</tr>
</tbody>
</table>

**Table 3 - Files Installed in "Simulation" Folder**

The files listed in Table 4 are installed by default, in the following location:

**C:\Program Files\Common Files\MatrikonOPC\Common**

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ACLConfig.exe</td>
<td>MatrikonOPC Tag Security Configuration Utility that configures tag-</td>
</tr>
</tbody>
</table>
### File Name | Description
--- | ---
EULA.pdf | End-User License Agreement in PDF format.
OEM_MATRKION_OPCODE.L | MatrikonOPC OEM Badge Library.
OPCAuto.dll | MatrikonOPC Automation Component – enables developers to access OPC data from client applications developed using automation tools.
opcd20_auto.doc | MatrikonOPC Automation Component interface standard.
OPCDAAuto.dll | MatrikonOPC HDA Automation Component – enables developers to access OPC data from client applications developed using automation tools such as Visual Basic, VBA, and VB Script.
opchda_ps.dll | The proxy-stub file that allows OPC clients to make remote connections to an OPC HDA server.
opchda10_auto.doc | Developer documentation for the HDA Automation Component.
OPCHDAAUTO.DLL | MatrikonOPC HDA Automation Component – enables developers to access OPC HDA data from client applications developed using automation tools.
PSTCFG.exe | Matrikon product configuration utility.
PSTcfgps.dll | Matrikon product configuration marshalling library.

#### Table 4 - Files Installed in "Common" Folder

The files listed in Table 5 are installed in the **WINDOWS\system32** folder:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>actxprxy.dll</td>
<td>ActiveX Interface Marshalling Library.</td>
</tr>
<tr>
<td>ExprEval.dll</td>
<td>Expression Evaluation Library for Alias Scaling Equations.</td>
</tr>
<tr>
<td>opc_aeps.dll</td>
<td>OPC Alarms and Events 1.10 Interfaces and Marshalling Library</td>
</tr>
<tr>
<td>opccomm_ps.dll</td>
<td>OPC Common Interfaces and Marshalling Library</td>
</tr>
<tr>
<td>Opcenum.exe</td>
<td>OPC server list component.</td>
</tr>
<tr>
<td>opcproxy.dll</td>
<td>OPC Data Access 2.05 and 1.0a Interfaces and Marshalling Library.</td>
</tr>
<tr>
<td>opcSec_PS.dll</td>
<td>OPC Security Interfaces and Marshalling Library</td>
</tr>
</tbody>
</table>

#### Table 5 - Files Installed in "system32" Folder

### Licensing

Most MatrikonOPC products require some form of licensing criteria be met to ensure that it functions successfully.

The MatrikonOPC Server for Simulation **supports neither software nor hardware licensing.**

### Contacting Support

The MatrikonOPC Customer Services department ([www.opcsupport.com](http://www.opcsupport.com)) is available 24 hours a day, seven days a week.
Contact MatrikonOPC Support using the information below, or send an email (support@MatrikonOPC.com).

For Monday to Friday **daytime support** requests, contact MatrikonOPC Support using the regional phone numbers provided in Table 6.

<table>
<thead>
<tr>
<th>Region</th>
<th>Office Hours</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>North America</strong></td>
<td>8:00 am-5:00 pm</td>
<td>+1-877-OPC-4-ALL</td>
</tr>
<tr>
<td>UTC/GMT -7 hours (MST)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Europe /Africa</strong></td>
<td>9:00 am-5:00 pm</td>
<td>+49-221-969-77-0 (Request OPC Support)</td>
</tr>
<tr>
<td>UTC/GMT +1 hours (CET)</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Middle East</strong></td>
<td>9:00 am-5:00 pm</td>
<td>+973-174-65363</td>
</tr>
<tr>
<td>UTC/GMT +3 hours</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Australia/Asia</strong></td>
<td>9:00 am-5:00 pm</td>
<td>+61-2-4908-2198 (Request OPC Support)</td>
</tr>
<tr>
<td>UTC/GMT +10 hours (AEST)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

* Toll-free regional numbers coming soon!

**Table 6 - MatrikonOPC Support Regional Contact Information**

For **after-hours support** in all regions, please use either of the following numbers. There is no extra charge from MatrikonOPC for calling their after-hours support numbers.

<table>
<thead>
<tr>
<th>Region</th>
<th>Contact Information</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All</strong></td>
<td>+1-780-231-9480</td>
</tr>
<tr>
<td></td>
<td>+1-780-264-6714</td>
</tr>
</tbody>
</table>

**Table 7 - After-Hours Support**
Configuration

The server’s Graphical User Interface (GUI) allows users to view and alter configuration parameters at run time. When a user views a configuration parameter, the information is retrieved and displayed. The updated parameters are sent as a group to the server when submitted.

This server functions without creating a configuration. However, you can use the aliases to define your own customized tag structure. The Alias Configuration section explains how to create user-defined aliases in place of regular OPC items, followed by four sections that cover saving, clearing, and loading configuration settings, and shutting down the server.

The Starting the MatrikonOPC Server for Simulation section of this manual shows users how to start the software. The next four sections describe the Tool Tray Menu, Control Panel, Configuration window, and the Options window, in detail.

Instructions for configuring the MatrikonOPC Server for Simulation as a DDE service appear in the Dynamic Data Exchange (DDE) section below.

Configuring Dynamic Data Exchange (DDE)

The server may act as a DDE service. In this way, a DDE client can request data from the server using the following DDE commands:

- **XTYP_POKE** - Write data to an item in the server.
- **XTYP_REQUEST** - Read data from an item in the server.
- **XTYP_ADVREQ** - Read latest data from an active advice loop.
- **XTYP_ADVSTART** - Create and activate an advice loop on a single item in the server.
- **XTYP_ADVSTOP** - Stop and destroy an advice loop on a single item in the server.

DDE service can be enabled or disabled using the checkbox. Note that these options will not be available if the server does not support DDE.

Items within the server can be referenced using the following syntax:

```
SERVICE_NAME |ITEM! SCANDETAILS
```

- **SERVICE_NAME** represents the name of the DDE service. The first edit box specifies the service name used by this server.
- **ITEM** refers to an item ID of a point within the server.
- **SCANDETAILS** is a combination of the desired scan rate of the item, and an access path. One or more delimiting characters separate the scan rate and access path. The second edit box can be used to change the delimiters. The delimiting characters must be provided when referencing an item in the server. However the scan rate and access path are optional. If no scan rate is specified, only data contained in the server cache will be available through DDE, and an advise loop will not be created.

Changes to the DDE options will not take effect until the server is restarted.

**Note:** DDE Name Syntax – DDE Names may be described in the following syntax: `SERVICE|TOPIC|NAME`

In this case, consider the **TOPIC** to be the item ID, and the **NAME** to be a combination of the scan rate and access path.
Starting the MatrikonOPC Server for Simulation

To launch the MatrikonOPC Server for Simulation, choose the appropriate shortcut from the Start menu.

To start the MatrikonOPC Server for Johnson Controls N2:

1. Click on the Windows Start button and select Programs -> MatrikonOPC -> Simulation, and choose MatrikonOPC Server for Simulation.
2. If the server is not installed as a Windows service, the server starts and the Matrikon logo appears in the Tool Tray (Figure 10), located by default in the system tray.

![Figure 10 - Tool Tray](image)

Tool Tray Menu

Note: If the server is installed as a Windows service, the Tool Tray and Tool Tray Menu are not available.

The Tool Tray Menu provides access to the Control Panel, the Configuration window, and the About screen. It also contains the commands to shut down the server.

To view the Tool Tray Menu:

1. Right-click your mouse on the Matrikon logo.
2. The Tool Tray Menu appears (Figure 11).

![Figure 11 - Tool Tray Menu](image)

Table 8 describes the commands in the Tool Tray Menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Control Panel</td>
<td>Displays the configuration control panel.</td>
</tr>
<tr>
<td>Configure</td>
<td>Displays the main Configuration window.</td>
</tr>
<tr>
<td>Shutdown</td>
<td>Shuts down the server.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the server’s Welcome screen, which includes information about the software.</td>
</tr>
</tbody>
</table>

Table 8 - Tool Tray Menu Commands

Control Panel

Note: If the server is installed as a Windows service, the Control Panel is not available.

The Control Panel displays the server’s status, system time, and number of clients connected to the server. The Control Panel allows users to:

- Access the Configuration window.
MatrikonOPC Server for Simulation v1.5.0.0 User’s Manual

- Access the About screen.
- Execute the command to shut down the server.

The Control Panel stays on top of every other window on the desktop to help monitor the status of the server.

**To view the Control Panel:**

1. Right-click your mouse on the Matrikon logo.
2. The Tool Tray Menu appears.
3. From the Tool Tray Menu, select the Show Control Panel menu option.
4. The Control Panel (Figure 12) appears.

![Figure 12 - Control Panel](image)

5. To "window shade" the Control Panel so that it displays only the client count, double-click your mouse on the title bar.

Table 9 describes the commands in the Tool Tray Menu.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>Displays the current status of the server.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the current time.</td>
</tr>
<tr>
<td>Clients</td>
<td>Displays the total number of OPC clients presently connected to the server.</td>
</tr>
<tr>
<td>Configure</td>
<td>Displays the main Configuration window.</td>
</tr>
<tr>
<td>Shutdown</td>
<td>Shuts down the server.</td>
</tr>
<tr>
<td>About</td>
<td>Displays the server’s Welcome screen, which includes information about the software.</td>
</tr>
</tbody>
</table>

**Table 9 - Control Panel Commands**

**Configuration Window**

**Note:** If the server is installed as a Windows service, the Tool Tray Menu and Control Panel are not available. In this case, the Configuration window is then accessed via the Windows Start menu.

The Configuration window is used to configure aliases. It displays the current configuration and allows users to change configuration parameters.

**To view the Configuration window:**

1. From the Tool Tray Menu or the Control Panel, select Configure.
2. The Configuration window (Figure 13) appears.
Table 10 describes the commands in the **Configuration** window.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main Menu</strong></td>
<td>Provides access to the <strong>File</strong>, <strong>Edit</strong>, <strong>View</strong>, <strong>Tools</strong>, and <strong>Help</strong> menus.</td>
</tr>
<tr>
<td><strong>Main Toolbar</strong></td>
<td>Provides shortcut buttons for commands in the <strong>Main Menu</strong>.</td>
</tr>
<tr>
<td><strong>Current Configuration</strong></td>
<td>Displays a tree of configuration objects currently defined in the server. Select an object to display its current settings in the right-hand panel.</td>
</tr>
<tr>
<td><strong>Server Configuration</strong></td>
<td>Server configuration is not required for MatrikonOPC Server for Simulation.</td>
</tr>
<tr>
<td><strong>Alias Configuration</strong></td>
<td>Define aliases and alias groups under this node.</td>
</tr>
<tr>
<td><strong>Object Settings Panel</strong></td>
<td>Displays the current settings of the object presently selected in the tree.</td>
</tr>
<tr>
<td><strong>Statistics Panel</strong></td>
<td>Displays available statistics for the object presently selected in the tree: <strong>Sent</strong>, <strong>Received</strong>, <strong>Timed Out</strong>, <strong>Retried</strong>, <strong>Failed</strong>, <strong>Overrun</strong>.</td>
</tr>
</tbody>
</table>
The following sections describe the menus available from the Configuration window, and what they are used for.

**File Menu**
Table 11 describes the File menu commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Clears the current configuration and starts a new one. If OPC clients are still connected to the server, the user is prompted for confirmation before continuing.</td>
</tr>
<tr>
<td>Open</td>
<td>Clears the current configuration and loads a new one from an existing file. Displays the Open Configuration window to prompt for the file name. If OPC clients are still connected to the server, the user is prompted for confirmation before continuing.</td>
</tr>
<tr>
<td>Save</td>
<td>Saves the current configuration to an XML file. Displays the Save Configuration window to prompt for a new file name if the configuration is new and has not been saved before.</td>
</tr>
<tr>
<td>Save As</td>
<td>Saves the current configuration to an XML file. Displays the Save Configuration window to prompt for a new file name.</td>
</tr>
<tr>
<td>Export Aliases</td>
<td>Exports all currently configured aliases to a CSV file. Displays the Export Aliases window to prompt for a file name.</td>
</tr>
<tr>
<td>Import Aliases</td>
<td>Clears all aliases and imports new ones from a CSV file. Displays the Import Aliases window to prompt for an existing file name.</td>
</tr>
<tr>
<td>Shutdown Server</td>
<td>Closes the current configuration and shuts down the server after signalling the shutdown event to all connected clients. If OPC clients are still connected to the server, the user is prompted for confirmation before continuing.</td>
</tr>
<tr>
<td>Close</td>
<td>Hides the main Configuration window. The server shuts down after a short delay if no OPC clients are currently connected to the server.</td>
</tr>
</tbody>
</table>

**Edit Menu**
Table 12 describes the Edit menu commands that appear when the currently selected object appears under the Server Configuration node.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo/Can’t Undo</td>
<td>Not implemented.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>✗ Delete</td>
<td>Removes the currently selected object from the server configuration. Prompts the user for confirmation before continuing to see if the OPC clients have reference to items associated with the selected object or one of its children. Does not remove such objects but simply disables them and sets them to “marked for deletion”.</td>
</tr>
<tr>
<td>📑 Define New</td>
<td>Displays the Insert New Object window used to create a new configuration object under the currently selected configuration object.</td>
</tr>
</tbody>
</table>

Table 12 - Edit Menu Commands (Server Configuration)

Table 13 describes the Edit menu commands that appear when the currently selected object appears under the Alias Configuration node.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo/Can’t Undo</td>
<td>Not implemented.</td>
</tr>
<tr>
<td>❅ Rename</td>
<td>Renames the currently selected alias group. This option is only available once a group has been created and then selected.</td>
</tr>
<tr>
<td>✗ Delete Alias Group</td>
<td>Removes the currently selected alias group and all subordinate groups and aliases.</td>
</tr>
<tr>
<td>Delete Alias</td>
<td>Removes the currently selected aliases.</td>
</tr>
<tr>
<td>📑 Insert Alias Group</td>
<td>Creates a new alias group under the currently selected alias group.</td>
</tr>
<tr>
<td>Insert New Alias</td>
<td>Displays the Insert New Alias window used to create a new alias under the currently selected alias group.</td>
</tr>
</tbody>
</table>

Table 13 - Edit Menu Commands (Alias Configuration)

View Menu

Table 14 describes the View menu commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Statistics</td>
<td>Displays/hides general communication statistics for the currently selected object.</td>
</tr>
<tr>
<td>Reset Statistics</td>
<td>Resets all statistics for the currently selected object to zero.</td>
</tr>
<tr>
<td>Defaults</td>
<td>Displays the Server Defaults window used to configure the default settings for the various types of communication objects available in the server.</td>
</tr>
<tr>
<td>✗ Refresh</td>
<td>Rebuilds the tree display of the server configuration and fully expands all branches.</td>
</tr>
<tr>
<td>Options</td>
<td>Displays the Options window used to change general server options.</td>
</tr>
</tbody>
</table>

Table 14 - View Menu Commands

Tools Menu

Table 15 describes the Tools menu commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📱 DCOM Configurator</td>
<td>Launches the Microsoft Distributed COM Configuration Properties</td>
</tr>
</tbody>
</table>
utility. This utility can be used to edit DCOM settings for specific COM servers to allow client applications on remote computers to connect to the server.

Launches MatrikonOPC Explorer, which is a general-purpose OPC client included with all MatrikonOPC servers that may be used to test the capabilities of the software. For more information, refer to the MatrikonOPC Explorer User’s Manual.

Launches the **Enter server password** window where you are asked to enter the security password set during the installation of the server. The default password set during the installation of this server is **MatrikonOPC**. The MatrikonOPC Tag Security Configuration Utility screen is then displayed which allows you to configure security settings. For more information, refer to **Appendix E – Security**.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View Tags</strong></td>
<td>Launches MatrikonOPC Explorer, which is a general-purpose OPC client included with all MatrikonOPC servers that may be used to test the capabilities of the software. For more information, refer to the MatrikonOPC Explorer User’s Manual.</td>
</tr>
<tr>
<td><strong>Security Settings</strong></td>
<td>Launches the <strong>Enter server password</strong> window where you are asked to enter the security password set during the installation of the server. The default password set during the installation of this server is <strong>MatrikonOPC</strong>. The MatrikonOPC Tag Security Configuration Utility screen is then displayed which allows you to configure security settings. For more information, refer to <strong>Appendix E – Security</strong>.</td>
</tr>
</tbody>
</table>

**Help Menu**

Table 16 describes the **Help** menu commands.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MatrikonOPC on the Web</strong></td>
<td>Opens a link to the MatrikonOPC web site.</td>
</tr>
<tr>
<td><strong>User’s Manual</strong></td>
<td>Opens this <strong>User’s Manual</strong>.</td>
</tr>
<tr>
<td><strong>About</strong></td>
<td>Displays the <strong>Welcome</strong> screen, which includes information about the software version.</td>
</tr>
</tbody>
</table>

**Options Window**

The **Options** window is used to edit the server’s options and contains four tabs: **General**, **General Logging**, **Interface Logging**, and **Advanced**.

**General Options**

The **General** tab allows users to edit general server options (i.e., settings).

**To view the General options:**

1. On the **Configuration** window, from the **View** menu, select the **Options** menu item.
2. The **Options** window appears.
3. From the **Options** window, select the **General** tab (Figure 14).
Table 17 describes the fields available on the **General** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Save current configuration on shutdown</strong></td>
<td>Automatically saves the current configuration to the specified file before shutting down, if selected.</td>
</tr>
<tr>
<td><strong>Backup: X copies</strong></td>
<td>Automatically keeps up to the specified number (i.e., X) of backup copies of the configuration file when saving the configuration.</td>
</tr>
<tr>
<td><strong>Load configuration on setup</strong></td>
<td>Automatically loads a configuration from the specified file when starting up, if selected.</td>
</tr>
<tr>
<td><strong>Filename</strong></td>
<td>Displays the full path of an existing file for load and save operations. Click on the ellipsis button (…) to display the <strong>Open</strong> window used to select an existing file name.</td>
</tr>
<tr>
<td><strong>Launch configuration program on startup</strong></td>
<td>Automatically launches the configuration utility when starting up as a local executable (rather than a Windows service), if selected.</td>
</tr>
<tr>
<td><strong>Restrict items to preconfigured aliases</strong></td>
<td>Prevents OPC clients from adding items other than configured aliases, if selected.</td>
</tr>
</tbody>
</table>
Note: The server loads these settings from the Windows registry upon start-up. Changes to the General options settings take effect when the server is restarted.

General Logging Options
The General Logging tab allows users to edit general logging options.

To view the General Logging options:

1. On the Configuration window, from the View menu, select the Options menu item.
2. The Options window appears.
3. From the Options window, select the General Logging tab (Figure 15).

Table 17 - General Options Tab Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>only</td>
<td></td>
</tr>
</tbody>
</table>

Table 18 - General Logging Options Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable activity logging</td>
<td>Enables/disables general activity logging at the specified detail level</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>General Activity Logging Filename</td>
<td>Displays the full path for the general activity log file. Click on the ellipsis button (…) to display the Open window used to select an existing file name. The default path is C:\Program Files\Common Files\MatrikonOPC\Common\PSTCFGMatrikon.OPC.Simulation.1.LOG.</td>
</tr>
<tr>
<td>Filter String</td>
<td>Match string for filtered log is displayed.</td>
</tr>
<tr>
<td>Filtering Filename</td>
<td>Displays the full path for the filtered log file. Click on the ellipsis button (…) to display the Open window used to select an existing file name.</td>
</tr>
</tbody>
</table>

**Table 18 - General Logging Options Tab Fields**

**Note:** General Logging options settings take effect immediately.

**Interface Logging Options**

The Interface Logging tab allows users to view and edit COM interface logging options.

**To view the Interface Logging options:**

1. On the Configuration window, from the View menu, select the Options menu item.
2. The Options window appears.
3. From the Options window, select the Interface Logging tab (Figure 16).
Table 19 describes the fields available on the **Interface Logging** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable logging</td>
<td>Enables/disables interface logging at the specified detail level (High, Medium, Low, or None), if selected. Generates a separate log file for each client named PST###.TMP in the server installation directory. \n<strong>Note:</strong> This option should <strong>not</strong> be selected unless users are debugging a problem as this will have a negative effect on performance of the OPC server.</td>
</tr>
<tr>
<td>Commit all log file writes</td>
<td>Purges the file buffer after each message is logged in the event of an unexpected server shut down.</td>
</tr>
</tbody>
</table>

**Table 19 - Interface Logging Options Tab Fields**

**Note:** Interface Logging options settings take effect when the next OPC client connects to the server.
Advanced Options
The Advanced tab allows users to view and edit advanced server options.

To view the Advanced options:
1. On the Configuration window, from the View menu, select the Options menu item.
2. The Options window appears.
3. From the Options window, select the Advanced tab (Figure 17).

Table 20 describes the fields available on the Advanced options tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OPC Group Update Rate (minimum)</td>
<td>Minimum update rate (milliseconds) allowed for an OPC group. Prevents OPC clients from requesting update rates that are impossible to achieve or that cause heavy CPU loads. The default value is 100 ms.</td>
</tr>
<tr>
<td>Time granularity</td>
<td>OPC server group scan thread interval (milliseconds). Determines the maximum resolution for data change detection. Time granularity should always be equal to or less than the minimum group update</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>rate.</td>
<td>Configure the way the server provides data through DDE.</td>
</tr>
</tbody>
</table>

**Table 20 - Advanced Options Tab Fields**

*Note:* The server loads these settings from the Windows registry on start-up. Changes to **Advanced** options settings take effect when the server is shut down and restarted.

**Server Configuration**

No configuration is necessary.

**Alias Configuration**

MatrikonOPC servers, including this one, provide the ability to create user-defined aliases that can be used in place of regular OPC items. This feature is particularly useful when the item path for a given server is very complex or difficult to remember, for example: `Com1.Radio1.Unit1.41.4.123`.

Servers can also be configured so that client applications have access to configured aliases only, rather than every available item.

This section of the manual describes how to create and edit aliases using the **Configuration** window.

*Note:* It is not necessary to define aliases before accessing server data items from an OPC client.

**Inserting Alias Groups**

*Note:* Alias Groups are used to contain one or more configured aliases.

**To insert an Alias Group:**

1. On the **Configuration** window, select **Alias Configuration** or a previously configured **Alias Group**.
2. From the **Edit** menu, choose **Insert Alias Group** or click on the button.
3. A new **Alias Group** folder appears.
4. Enter a new name for the **Alias Group**, and press **Enter**.
5. The **Alias Group** is renamed.

**Renaming Alias Groups**

*Note:* Alias Groups can be renamed after they have been created.

**To rename an Alias Group:**

1. On the **Configuration** window, select an **Alias Group**.
2. From the **Edit** menu, choose **Rename** or click on the button.
3. The **Alias Group** is renamed.

**Inserting New Aliases**

Use the **Insert New Alias** window (Figure 18) to insert a new alias into an Alias Group, or insert a new alias on its own directly under the Alias Configuration node.
Table 21 describes the components of the **Insert New Alias** window.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Name for the alias (unique within the alias group).</td>
</tr>
<tr>
<td><strong>Item Path</strong></td>
<td>Fully-qualified item ID for the OPC item to which the alias refers. Click on the ellipsis button (…) to display the <strong>Item Path Browser</strong> window used to select an existing OPC item on the server. Alternatively, leave the item path blank to use the alias as a general in-memory variable. When doing so, either define the data type for the alias point as something other than <strong>Default</strong>, or have the alias set for reading and define the data type while writing values to the alias from an OPC client. This component is disabled when the Calculation form of scaling is used. Item paths are specified in the calculation itself.</td>
</tr>
<tr>
<td><strong>Data Type</strong></td>
<td>Set the value of the OPC item to the specified type unless <strong>Default</strong> is selected. Also serves as the “canonical” data type for the alias.</td>
</tr>
<tr>
<td><strong>Read only</strong></td>
<td>When this checkbox is selected, it prevents OPC clients from writing values to the alias. This option is not available for Calculation aliases, as they are read-only.</td>
</tr>
<tr>
<td><strong>Update Rate</strong></td>
<td>Update rate (milliseconds) to use with the <strong>Poll when inactive</strong> option.</td>
</tr>
<tr>
<td><strong>Poll when inactive</strong></td>
<td>If selected, continues updating the value for the alias at the specified update rate even if there are no OPC clients currently accessing the alias.</td>
</tr>
<tr>
<td><strong>Save</strong></td>
<td>Save changes to the alias and hide the window.</td>
</tr>
<tr>
<td><strong>Save &amp; Create New</strong></td>
<td>Save changes to the alias and begin configuring a new one.</td>
</tr>
<tr>
<td><strong>Default to new</strong></td>
<td>Pressing <strong>Enter</strong> activates the <strong>Save &amp; Create New</strong> button rather than the <strong>Save</strong> button, if selected.</td>
</tr>
<tr>
<td><strong>Scaling &gt;&gt;</strong></td>
<td>Enables scaling for the alias (displays scaling options).</td>
</tr>
<tr>
<td><strong>&lt;&lt; No Scaling</strong></td>
<td>Disables scaling for the alias (hides scaling options).</td>
</tr>
<tr>
<td><strong>Cancel</strong></td>
<td>Discards changes to (abandon creation of) the alias and hides the window.</td>
</tr>
</tbody>
</table>

Table 21 - **Insert New Alias Window Options**
By selecting the **Scaling >>** button, the **Insert New Alias** window can be expanded to display Scaling Options (Figure 19). The available forms of scaling include: Simple text **Expressions**, **Calculation**, **Linear**, **Square Root**, and **Gain/Offset**.

![Figure 19 - Insert New Alias Window Scaling Options](image)

Table 22 describes the **Scaling Options** for the **Insert New Alias** window.

<table>
<thead>
<tr>
<th>Tab</th>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Expression</td>
<td>Input</td>
<td>Simple text equation to apply to incoming values (reads). Click on the ellipse button (…) to display the Expression Wizard screen used to help build a formula. For more information, refer to the Expression Wizard section in this manual.</td>
</tr>
<tr>
<td></td>
<td>Output</td>
<td>Simple text equation to apply to outgoing values (writes). Click on the ellipse button (…) to display the Expression Wizard screen used to help build a formula. For more information, refer to the Expression Wizard section in this manual.</td>
</tr>
<tr>
<td>Calculation</td>
<td>Input</td>
<td>Calculation equation to apply to incoming values (reads). Click on the ellipse button (…) to display the Item Path Browser screen used to add item paths to this field. For more information, refer to the Item Path Browser section in this manual.</td>
</tr>
<tr>
<td>Linear and Square Root</td>
<td>Raw High</td>
<td>Maximum expected raw value of the OPC item.</td>
</tr>
<tr>
<td></td>
<td>Raw Low</td>
<td>Minimum expected raw value of the OPC item.</td>
</tr>
<tr>
<td></td>
<td>Scaled High</td>
<td>Maximum desired scaled value for the alias (corresponds to Raw High).</td>
</tr>
<tr>
<td></td>
<td>Scaled Low</td>
<td>Minimum desired scaled value for the alias (corresponds to Raw Low).</td>
</tr>
<tr>
<td></td>
<td>Clamp High</td>
<td>Clamp the scaled value at the high limit to prevent it from going out of range.</td>
</tr>
<tr>
<td></td>
<td>Clamp Low</td>
<td>Clamp the scaled value at the low limit to prevent it from going out of range.</td>
</tr>
<tr>
<td>Gain/Offset</td>
<td>Gain</td>
<td>Scaling factor. (No limits are assumed.)</td>
</tr>
<tr>
<td></td>
<td>Offset</td>
<td>Scaling offset.</td>
</tr>
</tbody>
</table>

*Table 22 - Insert New Alias Window Scaling Options*
Notes:

- The data type for scaled values is double-precision real unless the alias data type is specified.
- Using invalid settings, such as zero-zero for the high-low range in Linear scaling, may be fatal to the server, OPC clients, and communications.
- The OPC item values must be numeric for Linear, Square Root, and Gain/Offset scaling to work.
- The OPC item values must be non-negative for Square Root scaling to work. Otherwise, the scaled value will be -1 with a bad quality.
- The server may be unable to load configuration files containing invalid scaling expressions, and may fail to start up properly. If this occurs, rename the configuration file so that the server will not load it upon start-up. Alternatively, edit the XML file to correct the invalid alias settings.

To insert a new alias:

Note: It is recommended that you create a new alias under an Alias Group rather than directly under the Alias Configuration node.

1. On the Configuration window, select Alias Configuration or a previously configured Alias Group.
2. The Contents table for that Alias Group is displayed on the right side of the Configuration window (Figure 20), listing the aliases it contains.

<table>
<thead>
<tr>
<th>Name</th>
<th>Item Path</th>
<th>Data Type</th>
<th>R/W</th>
<th>Update Rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>Alias1</td>
<td>Net1.Host1.Unit1.041.4.123</td>
<td>[Default]</td>
<td>R/W</td>
<td></td>
</tr>
<tr>
<td>Alias2</td>
<td>Net1.Host1.Unit1.041.4.124</td>
<td>[Default]</td>
<td>R/W</td>
<td></td>
</tr>
<tr>
<td>Alias3</td>
<td>Net1.Host1.Unit1.041.4.125</td>
<td>[Default]</td>
<td>R/W</td>
<td></td>
</tr>
</tbody>
</table>

Figure 20 - Contents Table

3. From the Edit menu, choose Insert New Alias.
4. The Insert New Alias window (Figure 18) appears.
5. Enter a name for the alias in the Name field.
6. Enter the item Path and ID for the item to which the alias refers, or click on the Browse button to navigate to the item.
7. Click on the Scaling button to enable scaling for the alias. Click on the No Scaling button to disable scaling and hide the Scaling Options.
8. The Scaling Options are displayed at the bottom of the Insert New Alias window (Figure 19).
9. Configure the Scaling Options as required (see Table 22 for a description of these options), by clicking the appropriate tab for the form of scaling that maybe required.

Note: Available forms of scaling include: Expression, Calculation, Linear, Square Root, and Gain/Offset. Expression, which uses an Expression Wizard to help build equations,
used frequently and is intended to view individual bits from registers. Refer to the Expression Wizard section for more information. Calculation, which uses the Item Path Browser to add items to calculation, is intended for calculations with involve multiple items. Refer to the Item Path Browser section for more information.

10. Configure the remaining fields as required (see Table 21 for a description of all the components).

11. Click on the Save button to save the alias.

**Editing Aliases**

**Note:** Aliases can be edited after they have been created using the Edit Alias window. This is virtually the same as the Insert New Alias window (Figure 18), with the exception that it appears after the alias has been created.

**To edit an alias:**

1. On the Configuration window, select the alias you want to change, and then double-click or press Enter.
2. The Edit Alias window appears.
3. Make the changes as required.

**Removing Aliases**

**Note:** Any alias that was created can be removed.

**To remove an alias:**

1. On the Configuration Window, select one or more aliases that you want to remove.
2. From the Edit menu, choose the Delete Alias menu option.
3. The alias is removed.

**Removing Alias Groups**

**Note:** Any Alias Group that was created can be removed.

**To remove an Alias Group:**

1. On the Configuration window, select the Alias Group you want to remove.
2. From the Edit menu, select the Delete Alias Group menu option or click on the \(	imes\) button.
3. The Alias Group is removed.

**Exporting Aliases**

**Note:** Use the Export Aliases window to export all currently configured aliases to a CSV file.

**To export all currently configured aliases:**

1. From the File menu, select the Export Aliases menu option or click on the \(\text{�}\) button.
2. The Export Aliases window appears.
3. Enter a file name for the CSV export file.
4. Click Save.
5. The aliases are exported.
Importing Aliases

Note: Use the Import Aliases window to clear all aliases and import new ones from a CSV file.

To import aliases from a CSV file:
1. From the File menu, select the Import Aliases menu option or click on the button.
2. The Import Aliases window appears.
3. Browse to the CSV file name.
4. Click Open.
5. The old aliases are cleared and the new ones are imported.

Expression Wizard

The Expression form of scaling uses an Expression Wizard to build formulas. The created formula is a simple text equation that is applied to either incoming values (i.e., reads), or outgoing values (i.e., writes).

Table 23 describes the Expression Wizard fields.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input/Output Expression</td>
<td>Displays the expression as it is created. This field is free-form which allows you to manually enter or edit information. This field reads Input Expression when creating an input or “read” expression. It reads Output Expression when creating an output or “write” expression.</td>
</tr>
<tr>
<td>Database field</td>
<td>This button is reserved for future enhancements.</td>
</tr>
<tr>
<td>Function</td>
<td>Select this button to display the Select function window which allows you to select the necessary function from those available.</td>
</tr>
<tr>
<td>Variable</td>
<td>Select this button to display the Select variable window which allows you to select the necessary variable from those available.</td>
</tr>
<tr>
<td>Operators</td>
<td>Select the applicable button to add the corresponding operator or operators to the expression.</td>
</tr>
<tr>
<td>Clear</td>
<td>Select this button to clear the Input/Output Expression field.</td>
</tr>
<tr>
<td>Validate</td>
<td>Select this button to validate the expression that appears in the Input/Output Expression field. If the expression is invalid, an error message is displayed. If the expression is valid, a message is displayed indicating there are no errors and also stating what the result is.</td>
</tr>
<tr>
<td>OK</td>
<td>Select this button to accept changes to (or the creation of) the expression.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Select this button to discard changes to (or abandon the creation of) the expression.</td>
</tr>
</tbody>
</table>

Table 23 - Expression Wizard Options

Notes:
- The Expression Wizard appears and functions the same for an input expression as it does for an output expression. The differences being the expression field label: Input Expression, Output Expression, and that one is for reads and the other for writes.
• If you are expecting to read a particular alias, create an **Input Expression**. If you are expecting to write to a particular alias, create an **Output Expression**.

**To create an Input or Output Expression:**
1. On the **Configuration** window, select **Alias Configuration** or a previously configured **Alias Group**.
2. The **Contents** table for that **Alias Group** is displayed on the right side of the **Configuration** window (Figure 20), listing the aliases it contains.
3. Either create a new alias (for instructions, see **To insert a new alias**), or
   - Double-click your mouse on an existing alias, or
   - Right-click your mouse on an existing alias and select the **Edit Alias** option from the displayed menu.
4. Click on the **Scaling** button to enable scaling for the alias. The **Scaling Options** are displayed at the bottom of the **Insert New Alias** window (Figure 19) or the **Edit Alias** window.
   - **Note:** Whether the **Insert New Alias** window or the **Edit Alias** window is displayed depends on whether you are creating a new alias or editing an existing one.
5. Select the **Expression** tab (Figure 21).

   ![Figure 21 - Expression Tab](image)

6. Click on the ellipsis button adjacent to the **Input** field (or **Output** field).
7. The **Expression Wizard** (Figure 22) is displayed.
Manually enter your new expression in the **Input/Output Expression** field and proceed to step 14, or perform steps 9 through 13 using a combination of the **Function**, **Variable**, and **Operators** buttons to create your expression, which will be displayed in the **Input/Output Expression** field as you build it.

9. Click on the **Function** button to go to the **Select function** (Figure 23) window. After selecting the required function, click on the **Continue** button to close the **Select function** window and return to the **Expression Wizard**.

![Figure 22 - Expression Wizard](image1.png)

**Figure 22 - Expression Wizard**

![Figure 23 - Select Function Window](image2.png)

**Figure 23 - Select Function Window**
10. Click on the **Variable** button to go to the **Select variable** (Figure 24) window. After selecting the required variable, click on the **OK** button to close the **Select variable** window and return to the **Expression Wizard**.

![Figure 24 - Select Variable Window](image)

11. If required, from the **Select variable** window, click on the **Modify variables** button to access the **User Defined Functions Editor** (Figure 25) which allows you to add, change, or delete variables.

![Figure 25 - User Defined Functions Editor](image)

12. The **Operators** buttons (Figure 26) allow you to enter an operation descriptor based on the selected button.
13. Click on the **Validate** button to determine whether or not the expression is valid.
14. If the expression is valid (i.e., a confirmation message is displayed), click on the **OK** button
to close the message window and return to the **Expression Wizard** screen.
15. Click on **OK** button on the **Expression Wizard** screen to close the wizard and display the
expression in either the **Input** or **Output** field, depending on which expression you defined.
16. From either the **Insert New Alias** or **Edit Alias** window, click on the **Save** button.
17. The **Insert New Alias** or **Edit Alias** window closes and you are returned to the
**Configuration** window.

**Item Path Browser**

The **Calculation** form of scaling uses the **Item Path Browser** to add item paths. The created
formula is a simple text equation that is applied to either incoming values (i.e., reads), or outgoing
values (i.e., writes).

Table 24 describes the **Item Path Browser** fields.

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Branch Hierarchy</td>
<td>Displays the branch hierarchy of the OPC server when browsing actions are being performed. The +/- symbols can be used to display/hide the branches below the specified branch. Left-clicking a branch displays its leaves in the <strong>Leaf List</strong> component.</td>
</tr>
<tr>
<td>Leaf List</td>
<td>Displays the list of leaves belonging to a selected branch from the <strong>Branch Hierarchy</strong>. Left-clicking a leaf enables the <strong>OK</strong> button.</td>
</tr>
<tr>
<td>OK</td>
<td>Select this button to add the selected item from the <strong>Leaf List</strong> to the <strong>Input/Output</strong> component of the <strong>Insert New Alias</strong> form.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Select this button to exit the <strong>Item Path Browser</strong> without adding any item paths.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select this button to refresh the browsing hierarchy in the <strong>Branch Hierarchy</strong> component.</td>
</tr>
</tbody>
</table>

**Table 24 – Item Path Browser Options**

**Note:** The **Item Path Browser** appears and functions the same for an input calculation as it does
for an output calculation.

**To create an Input or Output Calculation with item paths:**

1. On the **Configuration** window, select **Alias Configuration** or a previously configured **Alias Group**.
2. The **Contents** table for that **Alias Group** is displayed on the right side of the **Configuration** window (Figure 13), listing the aliases it contains.
3. Either create a new alias (for instructions, see **To insert a new alias**), or
   Double-click your mouse on an existing alias, or
Right-click your mouse on an existing alias and select the **Edit Alias** option from the displayed menu.

4. Click on the **Scaling** button to enable scaling for the alias. The **Scaling Options** are displayed at the bottom of the **Insert New Alias** window (Figure 18) or the **Edit Alias** window.

   **Note:** Whether the **Insert New Alias** window or the **Edit Alias** window is displayed depends on whether you are creating a new alias or editing an existing one.

5. Select the **Calculation** tab (Figure 27).

   ![Figure 27 - Calculation Tab](image)

   6. Click on the ellipsis button adjacent to the **Input** field (or **Output** field).

   7. The **Item Path Browser** (Figure 28) is displayed.

   ![Figure 28 – Item Path Browser](image)

   8. Browse the **Branch Hierarchy** until you find the branch containing the leaf you are interested in.

   9. Left-click your mouse on the leaf in the **Leaf List** and press the **OK** button. The item path is inserted (surrounded by square brackets) into the **Input/Output** component of the **Insert New Alias** form.

   10. Edit the calculation in the Input/Output component until the syntax is finalized. Refer to Table 37 and Table 38 for more information on the calculation syntax.

   11. Perform steps 9 through 11 for any additional item paths you wish to add to the calculation.
12. From either the **Insert New Alias** or **Edit Alias** window, click on the **Save** button.

13. The **Insert New Alias** or **Edit Alias** window closes and you are returned to the **Configuration** window.

**Saving a Configuration**

*Note:* When the server configuration is complete, use the **Save Configuration** window to save the configuration to an XML file.

**To save a configuration to an XML file:**

1. From the **File** menu, select the **Save As** menu option or click on the **Save** button (alternatively, users can choose **Save** or click ).
2. The **Save Configuration** window appears.
3. Enter a file name if saving the file for the first time.
4. Click **Save**.
5. The configuration is saved.

**Clearing a Configuration**

*Note:* Starting a new configuration will clear the existing one.

**To clear a configuration:**

1. From the **File** menu, choose the **New** menu option or click on the **New** button.
2. If OPC clients are still connected to the server, a warning message appears.
3. Click **OK**.
4. The configuration is cleared.

**Loading an Existing Configuration**

**To load an existing configuration file:**

1. From the **File** menu, select the **Open** menu option or click on the **Open** button.
2. The **Open Configuration** window appears.
3. Browse for the configuration file that you want to load.
4. Click **Open**.
5. If OPC clients are still connected to the server, a warning message appears.

   **Notes:**
   - At this stage, the connection between the server and the client needs to be broken.
   - When the new configuration is completely loaded, the changes will take effect in the OPC client.
6. Click **OK**.
7. The old configuration is cleared and the new configuration is loaded from the file.
Shutting Down the Server

To shut down the server:

1. On either the Control Panel or the Tool Tray Menu, select Shutdown. If the server is running as a local executable, choose Shutdown Server from the File menu or click on the button.

2. If OPC clients are still connected to the server, a warning message appears.

3. Click OK.

4. The server is shut down.

Note: The shutdown command is not available for the server if it runs as a Windows service. Services can be shut down only from the Service Control Manager applet in the Windows Control Panel.
OPC Data Items

This section describes the OPC data items used in the MatrikonOPC Server for Simulation.

Simulation Items

The MatrikonOPC Server for Simulation item ID syntax is as follows:

\[ \text{Source Type}.\text{Data Type} \]

Where:

- **Source Type** is the name source the data types belong to.
- **Data Type** is the name of the item and the data type the item is.

**Note:** The item `#OfflineMode` (browseable under Standard Simulation Items) has no functionality within the MatrikonOPC Server for Simulation.

Available Items

<table>
<thead>
<tr>
<th>Item ID</th>
<th>Data Type</th>
<th>R</th>
<th>W</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket Brigade.Int2</td>
<td>VT_I2</td>
<td>✓</td>
<td>✓</td>
<td>Short Read/Write item.</td>
</tr>
<tr>
<td>Bucket Brigade.String</td>
<td>VT_BSTR</td>
<td>✓</td>
<td>✓</td>
<td>String Read/Write item.</td>
</tr>
<tr>
<td>Random.R8</td>
<td>VT_R8</td>
<td>✓</td>
<td></td>
<td>Random Read Real item.</td>
</tr>
<tr>
<td>Random.ArrayOfString</td>
<td>VT_ARRAY</td>
<td>VT_BSTR</td>
<td>✓</td>
<td>Random value and size of Array of String Read item.</td>
</tr>
<tr>
<td>Saw-toothed Waves.Ui2</td>
<td>VT_UI2</td>
<td>✓</td>
<td></td>
<td>Unsigned short Saw-tooth wave Read item.</td>
</tr>
<tr>
<td>Triangle Waves.Int4</td>
<td>VT_I4</td>
<td>✓</td>
<td></td>
<td>Integer Triangle wave Read item.</td>
</tr>
<tr>
<td>Triangle Saves.Money</td>
<td>VT_CY</td>
<td>✓</td>
<td></td>
<td>Currency Triangle wave Read item.</td>
</tr>
</tbody>
</table>

Table 25 - Available Items

Examples

The following are examples of valid item IDs:

- **Bucket Brigade.Money**
- **Random.Real4**
- **Saw-toothed Waves.ArrayOfReal8**

Dynamic Item Creation

The OPC Server for Simulation has the ability to create many more items then what can be initially browsed for though the browsing interface. Any item that is added under a simulation category is a valid OPC item for the Simulation server. For example **Bucket Brigade.xxx** and **Square Waves.yyy** are valid items that can be added. The behaviour of these items that are added will always be the same as the category to which they belong (e.g., a **Bucket Brigade** item will be readable and writable but cannot change on its own, a **Saw-Toothed Wave** will ramp up to the maximum and then start coming back down). Any new automatically-created item is of the type
**VT_BSTR.** This enables the Simulation server to easily create thousands of tags with data, with no configuration required.
Diagnostics

The server supplies diagnostic information to assist operators and support personnel with troubleshooting communication problems and software faults.

Logging

All MatrikonOPC servers produce log files that record errors and debugging information. The log files can be extremely valuable for troubleshooting. As such, it is important to note that the default log level is set to low. The General Logging tab of the Options dialogue in the main configuration window contains settings to control server logging.

General Activity Logging records information about the internal workings of the OPC server. It is useful for troubleshooting problems with configuration and device communication. Interface Activity Logging records information about the client/server OPC communication. It is useful for troubleshooting compliance issues.

For General logging, the higher the log level, the more information that is recorded. However, server performance may decrease at higher log levels. The recommended operating level is Medium. More log levels are available for both types of logging which record more detailed information, as well as the ability to output log statements to a console window at run time. Contact MatrikonOPC support for further instructions on how to enable the higher log levels and console logging.

For Interface logging, the log level can be considered very high and therefore should never be used during normal operation of the OPC server unless specifically working on problems related to interfacing.

MatrikonOPC Sniffer is a useful tool for logging OPC client/server communication. It enhances the Interface Activity Logging by recording the client-side transactions. It can also be used with other OPC servers. MatrikonOPC Sniffer is a utility used to troubleshoot OPC client/server interoperability issues. Contact the MatrikonOPC Sales department for further information about this product, or use the following link to access the Matrikon Sniffer Download.

In general, the server logs all errors and other information of immediate importance to the user at the low detail level, all warnings and other information of moderate importance to the user at a medium detail level, and additional information concerning the normal functioning of the software at a high detail level. The server also logs further information of concern to support personnel at the debug log level.

**Note:** The higher the log level, the slower the performance of the server. It is recommended that the log level be left at the default, unless troubleshooting needs to be performed.
Limitations

MatrikonOPC Server for Simulation has the following limitation:

1. **History** – the Simulation server has limited history and lists only the last 100 values per item.

Refer to the *MatrikonOPC Server for Simulation Release Notes* for known issues.
# Troubleshooting

The following section addresses some of the most common problems encountered, and questions asked, while using this OPC server. Please check the following Problems and Solutions before contacting the MatrikonOPC Support team.

## Problems and Solutions

### Server stops updating client with item values after 30 days

<table>
<thead>
<tr>
<th>Problem:</th>
<th>The server stops updating the client with item values after 30 days.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution:</td>
<td>The evaluation period for the license has expired. Contact the MatrikonOPC Support team.</td>
</tr>
</tbody>
</table>

### Server shuts down after five minutes when no clients connected

<table>
<thead>
<tr>
<th>Problem:</th>
<th>The server automatically shuts down after five minutes when there are no clients connected.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solution:</td>
<td>This is standard behaviour for COM servers. However, this behaviour can be overridden as shown in the following example:</td>
</tr>
</tbody>
</table>

⚠️ **Note:** Microsoft highly recommends that you back up the registry before editing it or making changes to it.

1. From the Run command, enter `REGEDIT`.
2. The Registry Editor (Figure 29) is launched.
3. In the Registry Editor, under HKEY_CLASSES_ROOT, look for the required program ID (e.g., Matrikon.OPC.Simulation.1).
4. Expand the program ID branch.
5. Click on the CLSID branch.
6. Record the global universal ID (GUID).

**Figure 29 - Registry Editor**
7. Under the **HKEY_CLASSES_ROOT\CLSID** branch, search for the GUID retrieved in the previous step (e.g., **HKEY_CLASSES_ROOT\CLSID\{024C7FFC-9CC3-476f-867A-BC3CAD79F4FE}\**).

8. Create a string value called **LockServer** in the Options branch underneath the GUID (e.g., **HKEY_CLASSES_ROOT\CLSID\{024C7FFC-9CC3-476f-867A-BC3CAD79F4FE}\Options\**).

9. Create a new value using the context menu and choose **New String Value** from the menu.

10. Set the value of the **LockServer** entry to 1.

    **Note:** To edit the value, select the entry and select the **Modify** menu option from the **Edit** menu.

11. Shut down the server and restart it for the change to take effect.

---

**Cannot configure client access paths, so cannot configure item options**

**Problem:** The OPC client does not provide a means to configure access paths, making it difficult to correctly specify the data acquisition options for the items.

**Solution:** The server provides a global parameter for configuring an escape character, to allow users to append communication options to the end of an item ID which would accommodate clients that do not support access paths.

Perform the following steps as shown (with example) below:
Note: Microsoft highly recommends that you back up the registry before editing it or making changes to it.

1. From the Run command, enter REGEDIT.
2. The Registry Editor is launched.
3. In the Registry Editor, under HKEY_CLASSES_ROOT, look for the required program ID (e.g., Matrikon.OPC.Simulation.1).
4. Expand the program ID branch.
5. Click on the CLSID branch.
6. Record the global universal ID (GUID).
7. Under the HKEY_CLASSES_ROOT\CLSID branch, search for the GUID retrieved in the previous step (e.g., HKEY_CLASSES_ROOT\CLSID\{024C7FFC-9CC3-476f-867A-BC3CAD79F4FE\}).
8. Create a string value called ItemIDEscapeCharacter in the Options branch underneath the GUID (e.g., HKEY_CLASSES_ROOT\CLSID\{024C7FFC-9CC3-476f-867A-BC3CAD79F4FE\}\Options).
   Note: To create a new value, use the context menu and select the New String Value menu option.
9. Set the value of ItemIDEscapeCharacter to a single character, such as “|” (pipe).
   Note: To edit the value, select the entry and select the Modify menu option from the Edit menu.
10. Shut down the server and restart it for the change to take effect.
11. Configure the ItemIDEscapeCharacter Item ID in the OPC client with the access path appended to the end with the configured escape character (e.g., ITEMID|ACCESSPATH).

Server cannot be configured; no Matrikon logo in Tool Tray

| Problem: | The server cannot be configured because there is no Matrikon logo in the Tool Tray. |
| Solution: | If the Server is running as a service, the Matrikon logo does not appear in the Tool Tray. To configure the server, start the configuration utility by using the shortcut to the OPC server in the Windows Start menu (this shortcut starts the Configuration utility as well as the OPC Server). |
| Note: | If the server configuration utility generates an "access denied" error on launch, the DCOM permissions have not been configured properly. |
### OPC client unable to create or read items under configured object (device)

**Problem:** The OPC client is unable to create or read items under a configured object or device.

**Solution:** Check the object configuration. Ensure that the **Enabled** checkbox is selected, and verify the access credentials are correct (e.g., Username, Password).

### Server does not retain settings

**Problem:** The server does not retain its previous settings and needs to be reconfigured each time it starts up.

**Solution:** In the **Configuration** window, choose **Options** from the **View** menu. Under the **General** tab, ensure that the **Load configuration on start-up** checkbox is selected and that the correct file name appears in the edit box (see **General Options**).

### Server cannot save configuration in XML format

**Problem:** The OPC server cannot save the configuration file in XML format.

**Solution:** Microsoft Internet Explorer 4.01 (or later) must be installed to use the `.XML` format.

### Server does not show up in the list of locally available program IDs in OPC client application

**Problem:** The server does not show up in a list of locally available program IDs in the OPC client application.

**Solution:** Make sure that a user with local administrative rights installs the OPC server so that it can create the necessary entries in the registry.

- Ensure OPCEnum is registered as a service, DCOM permissions are configured properly, and the OPCEnum service is running.

- Also, especially for older OPC clients that do not use the OPC server browser, make sure the client is running as a user that has **read** access to the registry.

### Server does not show up as a program ID in a remote OPC client application

**Problem:** The server does not show up in a list of available program IDs in the OPC client application on a remote machine.

**Solution:** Follow the steps found in **DCOM Manual** to copy the program ID from the server machine to the OPC client machine.

### Access denied or time-out error when connecting to remove server via DCOM

**Problem:** **Access Denied** error message appears, or time out occurs when trying to connect to a remote OPC server via DCOM.
### Server does not start up or client cannot connect

**Problem:** A client tries to connect to the server and fails, or the server does not start up.

**Solution:** Ensure that the access and launch permissions for the OPC server are set correctly. For more information, refer to the [DCOM Manual](#).

### About screen and Configuration window do not show up

**Problem:** The About screen and Configuration window do not show up when a remotely-connecting client or a client that runs as a Windows server (such as Aspen Technologies CIMIO OPC Manager) tries to launch the OPC server.

**Solution:** Either set the identity for the OPC server to the interactive user, or consider running the server as a Windows service. For more information, refer to Appendix A – Distributed COM (DCOM).

### DA 2.0 asynchronous I/O does not work

**Problem:** After installing an older OPC server, DA 2.05a asynchronous I/O no longer works.

**Solution:** The old installation program installed and registered its own (older) version of the OPC proxy/stub DLL.

Reinstall the standard OPC proxy/stub DLLs, using an up-to-date installation program or re-register them using the `REGSVR32` command-line utility (refer to the [OPC Compliance - Installation](#) section in this manual).

### Trouble communicating through a network

**Problem:** Problems communicating to the remote machine through a network.

**Solution:** Make sure users can ping the device. Use **Start** -> **Run** with command, **CMD**, to bring up a command window. Enter the following:

```
Ping ipaddress ( e.g. C:\temp>ping 127.0.0.1

Pinging 127.0.0.1 with 32 bytes of data:
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128
Reply from 127.0.0.1: bytes=32 time<10ms TTL=128

Ping statistics for 127.0.0.1:
    Packets: Sent = 4, Received = 4, Lost = 0 (0% loss),
    Approximate round trip times in milli-seconds:
```

---

**MatrikonOPC Server for Simulation v1.5.0.0 User’s Manual** 59
Minimum = 0ms, Maximum = 0ms, Average = 0ms)

Where ipaddress is the IP address of the user's machine. If it says “no response”, then there are likely network issues between the user’s machine and the remote machine.

**Note:** Refer to the [DCOM Manual](#) to further diagnose DCOM issues.

### How can OPC data be accessed through other applications?

**Problem:** How can I access OPC data in Microsoft Excel, Microsoft Word, or another application with support for Visual Basic, VBA, or VB Script?

**Solution:** Use the MatrikonOPC Automation Component to create a Visual Basic script that connects to a server, creates groups and items, and receives data change updates. Contact MatrikonOPC Support for examples of how to do this in Excel, Visual Basic, or in an HTML document.

### How can individual bits be accessed from an integer item?

**Problem:** How can individual bits be accessed from an integer item?

**Solution:** In order to do this, users will have to apply a mask to the value, which will null all of the bits in the integer value except the one that users want to keep.

For example, if the user wanted to isolate the third bit, they would have to apply a mask that is in binary which will only have the third bit present. In binary, this is the number 4 (0100).

To apply the mask, users must use the AND operator, which will leave a 1, if and only if, both the bits in that position are 1.

0110 1100  
+ 0000 0100  = 0000 0100

Data bit we want to access

In decimal notation, this would be expressed as 108 AND 4 = 4.

To do this in an OPC server, users would configure an alias to use the IF operator. With the example above, where the user wishes to access the third bit in the integer, the statement would appear as:

IF (INPUT AND 4 = 4, 1, 0)

Therefore, if the bit in position 3 is a 1, since 1 AND 1 =1, the IF statement would be true and would return a 1. If the bit in position is 0, 0 AND 1 = 0, the IF statement would return a false value, which is a 0.

### Server is using a large portion of CPU resources

**Problem:** Server is using 99% of CPU resources.
**Solution:** Check for the server’s Time Granularity setting by editing the ServerOptx.ini file located at: C:\Program Files\Matrikon\OPC\MatrikonOPC Server for Performance Monitor. Ensure that the granularity is not set to 0. It is not recommended to set the value lower than 100.

**Removing OPC server as a service**

**Problem:** How do I remove the OPC server as a service?

**Solution:** Re-register the OPC server executable using the /REGSERVER command-line switch.

**Starting server manually when installed as a service**

**Problem:** Does the server need to be started manually when it is installed as a service?

**Solution:** No, the first OPC client that tries to connect will start the OPC server.

Search the MatrikonOPC Support Knowledge Base at www.opcsupport.com to find the answers to other commonly-asked MatrikonOPC Server for Simulation questions.
**Un-Installation**

To successfully un-install MatrikonOPC Server for Simulation, using the Add or Remove Programs from the Microsoft Windows Control Panel is recommended.

**To un-install MatrikonOPC Server for Simulation:**

1. Click on the **Start** button and highlight the **Control Panel** item.
2. From the displayed menu, select **Add or Remove Programs**.
3. The **Add or Remove Programs** window is displayed.
4. Scroll through the list of currently installed programs and updates to find and select **MatrikonOPC Server for Simulation** (Figure 31).

![Figure 31 - Add/Remove Programs](image)

5. Click on the **Remove** button associated with the MatrikonOPC Server for Simulation program to initiate the un-install process.

6. The **MatrikonOPC Explorer – InstallAware Wizard** appears and the **Welcome to MatrikonOPC Server for Simulation Maintenance** screen (Figure 32) is displayed.
7. Select the **Remove** option button to uninstall MatrikonOPC Server for Simulation entirely.
8. Click on the **Next** button. The **Ready to Uninstall** window (Figure 33) is displayed.
9. Click on the **Next** button.

10. The **Uninstalling MatrikonOPC Server for Simulation** screen (Figure 34) appears and the uninstall takes place.
11. When the un-install has finished, the **MatrikonOPC Server for Simulation Setup Complete** screen (Figure 35) appears stating that MatrikonOPC Server for Simulation was successfully un-installed.
12. Click on the **Finish** button to complete the un-install and exit the Wizard.
13. The program no longer appears listed in the **Add or Remove Programs** window.
**OPC Compliance**

For more information on OPC, view the documents listed below (as well as other OPC Specifications) at [http://www.opcfoundation.org](http://www.opcfoundation.org).

- OPC Overview 1.0
- OPC Common Definitions and Interfaces 1.0
- OPC Historical Data Access Custom Interface Standard 1.20
- OPC Data Access Custom Interface Standard 2.05
- OPC Data Access Custom Interface Standard 3.00
- OPC Alarms and Events Custom Interface Standard 1.10

**Installation**

The server is by default installed as a local out-of-process COM server and enters its registration information in the Windows registry when instructed to do so with the `/REGSERVER` command-line option. The server installs itself as a Windows service and enters its registration information in the Windows registry when instructed to do so with the `/SERVICE` command-line option.

- Version-independent program ID is `Matrikon.OPC.Simulation`
- Version-specific program ID is `Matrikon.OPC.Simulation.1`
- Vendor information string under OPC sub-key is `Matrikon Inc (780) 448-1010 http://www.matrikon.com`
- Globally unique application ID is `{F1F07BB3-D2CB-4e68-A4BF-4888CE1FD9F2}`
- Globally unique class ID number is `{81BD69CB-47A4-49bc-B5BD-2CD55ACC2DDE}`
- Full path of 32-bit local Server executable by default is `C:\Program Files\Matrikon\OPC\Simulation`
- OPC Data Access Server 1.0 and 2.0 implemented component categories.

The server removes its registration information from the Windows registry when commanded to do so with the `/UNREGSERVER` command-line option.

**Common Interfaces**

The server supports the mandatory functionality specified in *OPC Common Definitions and Interfaces*. The server supports the following locales for result code translation:

- US English (0x0409)
- System default (0x0800)
- User default (0x0400)
- Neutral (0x0000).

The server allows the client to set the client name for each connection. The server supports the shutdown event notification client-side interface.

**Data Access**

The server supports the mandatory functionality specified in the *OPC Data Access Custom Interface Standard*. 
Groups
The server supports the addition, removal, and cloning of private groups. The server allows the client to manage group state.

- Name
- Active state
- Update rate (100 millisecond resolution)
- Time bias
- Dead-band (percent of analog item high-low range)

Items
The server supports the addition, removal, and validation of items in a group. The server allows the client to manage item configuration.

- Active state
- Requested data type
- Dead-band (percent of analog item high-low range)
- Sampling rate
- Buffer values (used only when sampling rate is enabled and is sampling faster than the group update rate).

Browsing and Item Properties
The server supports address space browsing.

- Hierarchical address space
- Simulate flat address space
- Branch/leaf name filter (pattern matching)
- Item data type filter
- Item access rights filter

The server supports the following mandatory item properties.

- Value, quality, and timestamp
- Canonical data type
- Access rights
- Scan rate

I/O Operations
The server supports synchronous I/O operations.

- Read active item values from cache.
- Read item values from device.
- Read items value from device based on how old the cache items value is.
- Read items without adding the item to an OPC group.
- Write control values to items (on device).
- Write control value, quality, and/or timestamp to items (if the server supports such features).
- Write control values without adding the item to an OPC group.

The server supports asynchronous I/O operations as defined for **DA 3.0**.
- Read items value from device based on how old the cache items value is.
- Write control value, quality, and/or timestamp (if the server supports such feature).

The server supports the data change event notification client-side interface as defined for **DA 3.0**.
- Keep-alive call-back indicating server is alive.

The server supports asynchronous I/O operations as defined for **DA 2.0**.
- Read items values from device
- Write control values to items (on device)
- Refresh active items from cache
- Cancel outstanding operations
- Enable/disable event notifications

The server supports the data change event notification client-side interface as defined for **DA 2.0**.
- Data change or dead-band exceeded
- Asynchronous refresh operation complete
- Asynchronous read operation complete
- Asynchronous write operation complete
- Asynchronous operation cancellation complete

The server supports asynchronous I/O operations as defined for **DA 1.0a**.
- Read items values from device
- Read items values from cache
- Write control values to items (on device)
- Refresh active items from cache
- Cancel outstanding operations

The server supports the data change event notification client-side interface as defined for **DA 1.0a**.
- Data change or dead-band exceeded – data with time stamps
- Data change or dead-band exceeded – data without time stamps
- Asynchronous write operation complete

**Alarms and Events Functionality**

The MatrikonOPC Server for Simulation can be used to simulate simple events and send notifications of these events to client applications. The events that can be generated fall into two categories:

- Simulated Event
- Simulated Item Creation Event
**Simulated Event**

A Simulated Event is generated every time a write operation is performed on a **Bucket Brigade** item of type string. An event notification containing the following attributes are sent to the client:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Bucket Brigade.String, which is a reference to the object that generated the event notification.</td>
</tr>
<tr>
<td>Time</td>
<td>The time that the event occurred.</td>
</tr>
<tr>
<td>Event Category</td>
<td>1 (set by the server).</td>
</tr>
<tr>
<td>Severity</td>
<td>1 (which indicates a low severity).</td>
</tr>
<tr>
<td>Message</td>
<td>The string that is written to the Bucket Brigade item by the user.</td>
</tr>
</tbody>
</table>

*Table 26 - Simulated Event - Event Notification Attributes*

**Simulated Item Creation Event**

A Simulated Item Creation Event is generated when a new simulation item is created.

**Note:** This is different than simply adding a pre-defined tag, such as **Bucket Brigade.Boolean** or **Square Waves.Int1**. An example of a new simulation item is **Bucket Brigade.xxx** or **Square Waves.yyy**. Thus, a new simulation item consists of a valid, existing simulation item type and a period followed by a string that does not refer to a pre-defined data type.

The event notification sent to the A&E client is as follows:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Source</td>
<td>Simulated item type, which is a reference to the object that generated the event notification.</td>
</tr>
<tr>
<td>Time</td>
<td>The time that the event occurred.</td>
</tr>
<tr>
<td>Event Category</td>
<td>2 (set by the server).</td>
</tr>
<tr>
<td>Severity</td>
<td>1 (which indicates a low severity).</td>
</tr>
<tr>
<td>Message</td>
<td>The following string: &quot;New simulation item created.&quot;</td>
</tr>
</tbody>
</table>

*Table 27 - Simulated Item Creation Event - Event Notification Attributes*

**Historical Data Access Functionality**

The MatrikonOPC Server for Simulation is capable of acting as a Historical Data Access server by caching values in a rolling buffer (which is capable of storing a maximum of 100 items) that can be read back using function calls contained in the HDA Custom Interface. An HDA client can be used to connect to the Simulation server and perform a variety of read and update operations on a variety of different simulation items. Performing an update operation will write data to the buffer, while performing a read operation allows the user to view data that is already present in the buffer. The following table displays the types of operations that can be performed on each simulation item:

<table>
<thead>
<tr>
<th>Simulation Item</th>
<th>Updateable?</th>
<th>Readable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bucket brigade</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Random</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Read error</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>

*Table 28 - Historical Data Access Functionality*
The Simulation server supports a number of HDA read and update functions which are described in the following sub-sections.

**Read Functionality**

**ReadRaw**
Reads the values, qualities, and timestamps from the history buffer for the specified time domain for one or more items in a group.

**ReadAtTime**
Reads the values and qualities from the history buffer for the specified timestamps.

**ReadProcessed**
Computes aggregate values, qualities, and timestamps from the data in the history buffer for the specified time domain for one or more items. The aggregate functions are performed during the retrieval of the data. The aggregate functions supported are:

<table>
<thead>
<tr>
<th>Aggregation Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interpolation</td>
<td>Uses the linear straight-line interpolation method to estimate a value between known values.</td>
</tr>
<tr>
<td>Time average</td>
<td>Retrieve the time-weighted average data over the resample interval.</td>
</tr>
<tr>
<td>Minimum actual time</td>
<td>Retrieve the minimum value in the resample interval and the timestamp of the minimum value.</td>
</tr>
<tr>
<td>Minimum</td>
<td>Retrieve the minimum value in the resample interval.</td>
</tr>
<tr>
<td>Maximum actual time</td>
<td>Retrieve the maximum value in the resample interval and the timestamp of the maximum value.</td>
</tr>
<tr>
<td>Maximum</td>
<td>Retrieve the maximum value in the resample interval.</td>
</tr>
</tbody>
</table>

**ReadAttribute**
Reads attribute values and timestamps from the history buffer for the specified time domain for the item. The item attributes tracked by the Simulation server are:

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Attribute Name</th>
<th>Attribute Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>data_type</td>
<td>Data type.</td>
</tr>
</tbody>
</table>
### Attribute ID

<table>
<thead>
<tr>
<th>Attribute ID</th>
<th>Attribute Name</th>
<th>Attribute Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>description</td>
<td>Item description.</td>
</tr>
<tr>
<td>11</td>
<td>normal_maximum</td>
<td>High Engineering Units.</td>
</tr>
<tr>
<td>12</td>
<td>normal_minimum</td>
<td>Low Engineering Units.</td>
</tr>
<tr>
<td>13</td>
<td>itemid</td>
<td>Item ID.</td>
</tr>
<tr>
<td>-5</td>
<td>triangle</td>
<td>Triangle wave.</td>
</tr>
<tr>
<td>-4</td>
<td>square</td>
<td>Square wave.</td>
</tr>
<tr>
<td>-3</td>
<td>sawtooth</td>
<td>Saw-toothed wave</td>
</tr>
<tr>
<td>-2</td>
<td>random</td>
<td>Random</td>
</tr>
<tr>
<td>-1</td>
<td>bucket</td>
<td>Bucket Brigade</td>
</tr>
</tbody>
</table>

**Table 30 - Attributes Stored for Each Item by Simulation Server**

### Update Functionality

#### Insert
Inserts values and qualities into the history buffer at the specified timestamps for one or more items. If data is already present at the insertion point in the buffer, the insert operation fails and the message “data exists” is returned. If the maximum size of the buffer is exceeded (i.e., more than 200 items exist) as a result of an insert operation, items are deleted from the beginning of the buffer.

#### Replace
Replaces values and qualities in the history buffer at the specified timestamps for one or more items. This operation results in existing data being overwritten. If an attempt to replace a non-existent data point is made, the misleading error message, “data exists”, is returned and the replace operation fails.

#### InsertReplace
Inserts or replaces values and qualities at the specified timestamps for one or more items. If the item has a value at the specified timestamp, the new value and quality will replace the old one. If there is no value at that timestamp, the function will insert the new data.

### MatrikonOPC Server for Simulation Functionality

#### Alarm and Event Capabilities
Table 31 lists the events in the OPC Alarms and Events Custom Interface Standard v1.10 that are supported by the MatrikonOPC Server for Simulation.

<table>
<thead>
<tr>
<th>Event</th>
<th>Supported?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Condition-related</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Tracking-related</td>
<td>Not supported.</td>
</tr>
<tr>
<td>Simple</td>
<td>✓</td>
</tr>
</tbody>
</table>

**Table 31 - OPC Alarms and Events Custom Interface Standard v1.10 Events**

#### Historical Data Access Capabilities
Table 32 lists the read functions in the OPC Historical Data Access Custom Interface Standard v1.20 supported by the MatrikonOPC Server for Simulation.
### Table 32 - OPC Historical Data Access Custom Interface Standard v1.20 Read Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported?</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Synchronous</td>
<td>Asynchronous</td>
<td></td>
</tr>
<tr>
<td>ReadRaw</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>ReadProcessed</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>ReadAtTime</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>ReadModified</td>
<td>Not supported.</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>ReadAttribute</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
</tbody>
</table>

Table 33 lists the update functions in the OPC Historical Data Access Custom Interface Standard v1.20 supported by the MatrikonOPC Server for Simulation.

### Table 33 - OPC Historical Data Access Custom Interface Standard v1.20 Update Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported?</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Synchronous</td>
<td>Asynchronous</td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>Replace</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>InsertReplace</td>
<td>✓</td>
<td>✓</td>
<td></td>
</tr>
<tr>
<td>DeleteRaw</td>
<td>Not supported.</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>DeleteAtTime</td>
<td>Not supported.</td>
<td>Not supported.</td>
<td></td>
</tr>
</tbody>
</table>

Table 34 lists the annotation functions in the OPC Historical Data Access Custom Interface Standard v1.20 supported by the MatrikonOPC Server for Simulation.

### Table 34 - OPC Historical Data Access Custom Interface Standard v1.20 Annotation Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported?</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Synchronous</td>
<td>Asynchronous</td>
<td></td>
</tr>
<tr>
<td>Read</td>
<td>Not supported.</td>
<td>Not supported.</td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td>Not supported.</td>
<td>Not supported.</td>
<td></td>
</tr>
</tbody>
</table>

Table 35 lists the playback functions in the OPC Historical Data Access Custom Interface Standard v1.20 supported by the MatrikonOPC Server for Simulation.

### Table 35 - OPC Historical Data Access Custom Interface Standard v1.20 Playback Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported?</th>
</tr>
</thead>
<tbody>
<tr>
<td>ReadRawWithUpdate</td>
<td>Not supported.</td>
</tr>
<tr>
<td>ReadProcessedWithUpdate</td>
<td>Not supported.</td>
</tr>
</tbody>
</table>

Appendix A – Distributed COM (DCOM)

DCOM is an object protocol that enables COM components (such as OPC clients and servers) to communicate directly with each other across a network. A certain amount of configuration is required on the system where the OPC server is installed to allow remote clients to connect to it over the network.

The following steps are suggestions only. Ask your Windows Network Administrator for more information about the settings that you should use, especially between different domains.

Readers should be familiar with DCOM and with Windows 2000 security features and security administration. Information regarding Distributed COM and various links to related sites, white papers, specs, etc, can be found at [http://www.microsoft.com/com/tech/DCOM.asp](http://www.microsoft.com/com/tech/DCOM.asp).

Specifications on DCOM/COM and release notes on COM+ can be found in the MSDN Online Library at [http://www.microsoft.com/com/resources/specs.asp](http://www.microsoft.com/com/resources/specs.asp).

DCOM Configuration Utility

Start the DCOM configuration utility either from the server configuration utility or from the command-line (DCOMCNFG). Answer, yes to any message boxes that appear (allowing the utility to assign application ID entries to those servers that don't already have them).

The main window for DCOMCNFG allows the user to either configure default settings for all COM servers or else to configure settings for a specific server chosen from the list. The former will affect all servers configured to use the default settings. The latter will affect the selected server only.

DCOM settings are stored in the registry and loaded by COM (and OPC) servers at start-up. Therefore, server processes must be shut down and re-started for these changes to take effect.

Default Properties

The Default Properties tab contains settings that affect all DCOM communication on the machine.

- First of all, ensure that the Enable Distributed COM on this computer is selected so that the machine is available to others via DCOM.
- Select the Enable COM Internet Services on this computer to allow DCOM access to the machine from the Internet (check with your administrator).
- In general, the other settings do not need to be changed.

The Authentication Level specifies when COM should authenticate the identity of calling clients (each call, each packet, etc).

- Normally, it should be set to Connect, indicating that COM should authenticate clients when they first connect to a server. If it is set to None, then COM performs no authentication and ignores any access permission settings.

The Impersonation Level specifies whether servers can ascertain the identity of calling clients and whether they can then perform operations on the client's behalf (as if the server is the client).
• Normally, it should be set to **Identify**, allowing the server to identify the calling client to see if it is allowed access to a certain resource but not to actually access any of these resources as the client.

• Select the **Provide additional security for reference tracking** to make even the reference counting on COM objects secure. This setting is not generally required.

### Security Permissions

The most important DCOM settings for an OPC server are the security permissions. There are two ways for you to set these:

1. Change the specific settings for the server (recommended).
2. Change the default settings (not recommended) and make sure that the OPC server will use these.

Be certain that the access and launch permissions are correct for the server.

### Setting Security Permissions

To set the security permissions for an OPC Server:

1. Open the DCOM configuration utility.
2. Select the OPC server, and then click **Properties**.
3. The **Distributed COM Configuration Properties** window (Figure 36) appears.
4. Click on the **Security** tab to set the security for the server.
5. The **Distributed COM Configuration Security** tab (Figure 37) appears.

![Matrikon OPC Server for Simulation and Testing Properties](image)

**Figure 37 - Distributed COM Configuration Security Tab**

**Notes:**

- The **Access Permissions** contain an *Access Control List* of principals that are allowed to interact with objects supplied by a server.

- The **Launch Permissions** contain an *Access Control List* of principals that are allowed to start up a server process or service.

6. Include the names of users or user groups from trusted domains that you wish to be able to use the OPC server on this machine. Include the **Everyone** group to allow access to all users on a particular domain.

7. To set the **Access** permissions, click **Use custom access permissions** and then click **Edit**.

8. The **Registry Value Permissions** window (Figure 38) appears.
9. To add users to the list click **Add**.

10. The **Add Users and Groups** window (Figure 39) appears.

11. To add a user to the list, select the user, and then click **Add**. If the user you wish to add does not appear then click **Show Users**.
12. When you are done adding users, click **OK** to close the **Add Users and Groups** window. You can then choose to **Allow Access** or **Deny Access** for each user.

**Notes:**
- The procedure to set the launch permissions is similar to the above, but instead of choosing **Allow Access** for a user you would choose **Allow Launch**.
- The Configuration Permissions contain an **Access Control List** of principals that are allowed to modify the configuration information for a server. In other words, it indicates who is allowed to alter the registry entries for installed servers as well as who is able to access the registry for the purposes of installing new servers. It is usually simpler to install and configure servers as a user with local administrative rights.

13. To connect to an OPC server from outside of the domain, create a local user account on both the server and the client machine with identical **username** and **password**. Then, add the local user on the OPC server to the DCOM permissions. Use the local account on the client machine to connect to the OPC server.

## Server Identity

The **Identity** tab for a selected COM (or OPC) server specifies the user account that should be used when COM starts up the process. The available settings are different for servers that run as local executables as opposed to those that run as NT services.

It is strongly recommended that OPC servers should be installed to run as NT services if they are going to be accessed by remote clients via DCOM. This ensures that the server can always be accessed even if no one is presently logged on to the machine, and only one server process ever starts up. It also adds a greater degree of security in terms of who is able to shut down the server process.

Servers that run as local executables have the option of running as the launching user (the calling client—this is the default), the interactive user (the one currently logged onto the machine), or a specified user. It is usually best to use the interactive user or a specified user. Otherwise, remote clients might start up multiple separate server processes that are not accessible to others.

Servers that run as NT services should generally run as the local **System** account. Alternatively, the server can be set to run as a specified user, although this is usually done from the **Service Control Manager** applet rather than DCOMCNFG. **Access** and **Launch** permissions are particularly important when installing a server to run as an NT service.

## Default Protocols

The **Default Protocols** tab specifies the communication protocols available to DCOM. The order that protocols appear in the list indicates the priority in which they will be used (the topmost having the highest priority).

The more protocols that appear in the list, the better the chances of connecting to an OPC server on an unknown remote machine (such as at an OPC Interoperability Workshop). However, it may also take longer for DCOM to time out if a server machine is not present since it has to try each protocol in turn.

For most situations, it is best to remove all unused protocols from the list and only include those that are necessary for your network. For example, on a TCP/IP network, one would include the **Connection-oriented TCP/IP** protocol. Contact your IT personnel for more information about your network.
Evidence indicates that there are problems with the datagram-oriented protocols (such as UDP/IP) that can cause memory leaks in DCOM. Therefore, it is strongly recommended that these protocols be removed from the list of default protocols. Datagram-oriented protocols are not supported under Windows 2000 at all (although the DCOM configuration utility still allows you to configure them).

Remote Program ID

Before the **OPC Server Browser** became available, OPC client applications had to search the registry to generate a list of available OPC servers. Therefore, some older OPC clients need to have a program ID in the local registry in order to connect to a particular OPC server.

The simplest solution is to install the OPC server software on the client machine even if it is not used. Alternatively, use the following steps to copy a program ID to the client machine.

**Note:** This method may not work for every OPC client. Please check the client documentation for more information.

**WARNING:** Any changes made to the registry must be made with extreme caution!

1. Back up your registry.
2. On the server machine, run **REGEDIT** as a user that has access rights to the local registry.
3. Expand the **HKEY_CLASSES_ROOT** key.
4. Find the program ID(s) for the desired OPC server(s).
   
   **Note:** In the case of Matrikon OPC Servers, the ID has the form *Matrikon.OPC.Device*. If you quickly type the first few letters then **REGEDIT** should jump to the location of that key. Some servers may have both a version-specific as well as a version-independent program ID. In this case both IDs should be copied to the client machine.
5. For each program ID, select the key and choose **Export Registry File** from the **Registry** menu. Enter a file name, and then click **Save**. Be careful not to overwrite other export files that you are creating.
6. Copy the exported **REG** files to the client machine.
7. Merge the **REG** files into the registry of the client machine.
   
   **Note:** This should simply be a matter of double clicking on the file from the desktop of the client machine. Alternatively, run **REGEDIT** on the client machine and choose **Import Registry File** from the **Registry** menu, selecting each file in turn. This must be done as a user who has write access to the local registry.
8. Use **REGEDIT** to check that the program IDs have in fact, been copied.
9. Delete the **REG** files since they are no longer needed.
# Appendix B – Aliases

## Scaling Expressions

Alias scaling expressions may use any of the expression constructs listed in Table 36.

<table>
<thead>
<tr>
<th>Construct</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>‘text’</td>
<td>Text value (single quotation marks).</td>
<td>‘hello’ ‘Joe’s Alias’</td>
</tr>
<tr>
<td>+ - * /</td>
<td>Addition (or Append), Subtraction, Multiplication, and Division.</td>
<td>(3 * 7 + 1) / 8 – 2 ‘hi’ + ‘there’</td>
</tr>
<tr>
<td>= &lt; &gt; &lt;&gt; &lt;= &gt;=</td>
<td>Equal To, Less Than, Greater Than, Unequal To, Less or Equal To, Greater or Equal To.</td>
<td>3 &lt; 4</td>
</tr>
<tr>
<td>Not And Or</td>
<td>Logical Not, Logical And, Logical Or. May also be used for binary math.</td>
<td>(7 &gt;= 3) And (1 &lt;&gt; 0) (12 And 5) = 4</td>
</tr>
<tr>
<td>TIME</td>
<td>Current time as text.</td>
<td>‘The time is’ + TIME</td>
</tr>
<tr>
<td>DATE</td>
<td>Current date as text.</td>
<td>‘Today is’ + DATE</td>
</tr>
<tr>
<td>INT(x)</td>
<td>Returns the integer part of x.</td>
<td>INT(3.14) = 3</td>
</tr>
<tr>
<td>FRAC(x)</td>
<td>Returns the fractional part of x.</td>
<td>FRAC(3.14) = 0.14</td>
</tr>
<tr>
<td>SQRT(x)</td>
<td>Returns the square root of x.</td>
<td>SQRT(16) = 4</td>
</tr>
<tr>
<td>DIV(x, y)</td>
<td>Divides x by y.</td>
<td>DIV(42, 7) = 6</td>
</tr>
<tr>
<td>IF(expr, x, y)</td>
<td>Returns x if expression evaluates to TRUE, otherwise returns y.</td>
<td>IF(6 &lt;= 12, ‘OK’, ‘Bad’) = ‘OK’</td>
</tr>
<tr>
<td>TRUE FALSE</td>
<td>Constant Boolean true and false.</td>
<td>(5 &gt; 6) = FALSE</td>
</tr>
<tr>
<td>TYPEOF(x)</td>
<td>Returns the data type of x as a text description (‘STRING’, ‘INTEGER’, ‘FLOAT’, ‘BOOLEAN’, ‘ERROR’).</td>
<td>TYPEOF(‘hello’) = ‘STRING’</td>
</tr>
<tr>
<td>STR(x)</td>
<td>Converts the numeric value x to text.</td>
<td>STR(3.14) = ‘3.14’</td>
</tr>
<tr>
<td>UPPER(x)</td>
<td>Converts the text value x to all upper case or lower case letters, or the first</td>
<td>UPPER(‘alarm’) = ‘ALARM’</td>
</tr>
<tr>
<td>LOWER(x)</td>
<td></td>
<td>LOWER(‘ALARMS’) = ‘alarm’</td>
</tr>
<tr>
<td>PRETTY(x)</td>
<td></td>
<td>PRETTY(‘ALARM’) = ‘Alarm’</td>
</tr>
</tbody>
</table>
### Scaling Calculations

Calculations may contain references to any OPC item in the server's syntax. However, they may not contain references to other alias items. There are no limits on how many items can be used in a calculation. The only limiting factor may be performance related. To reference another OPC item in the calculation, wrap the items full item path in square brackets. For example to add the items `Com1.Rtu.Reg1` and `Com1.Rtu.Reg2` together, the correct expression would be:

\[
[\text{Com1.Rtu.Reg1}] + [\text{Com1.Rtu.Reg2}]
\]

If the OPC item being referenced in a calculation is not found within the servers address space, the server attempts to add it. If successful, the OPC server uses the update rate of the alias to update the OPC item.

If the OPC item being referenced in a calculation is found within the servers address space, the server creates a subscription to it using the lowest update rate of the item and the alias. For example, if the update rate of `Com1.Rtu.Reg1` is ten seconds and a subscription is created to an alias with an update rate of one second, the new update rate of the OPC item is one second.

When the subscription to the alias is cancelled, the item returns to using the previous update rate. However, if the option `Poll Always` is enabled for the alias, the server will always have a subscription to that alias and therefore the lower update rate of the alias is used.

In the event that the server cannot create a subscription to the OPC item, the alias quality reports `Bad, bad configuration`.

Alias scaling calculations may use any of the operators listed in Table 37.

<table>
<thead>
<tr>
<th>Construct</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Minus operator.</td>
<td>x - y</td>
</tr>
<tr>
<td>-</td>
<td>Unary minus operator.</td>
<td>-x</td>
</tr>
<tr>
<td>!</td>
<td>Not logical operator. Returns 1 if x is 0, else returns 0.</td>
<td>!x</td>
</tr>
</tbody>
</table>

Table 36 - Expressions Constructs for Alias Scaling
### Calculation Operators for Alias Scaling

<table>
<thead>
<tr>
<th>Construct</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>!=</td>
<td>Not equal logical operator. Returns 1 if true, 0 if false.</td>
<td>x != y</td>
</tr>
<tr>
<td>%</td>
<td>Modulo; find remainder of the division of x by y.</td>
<td>x % y</td>
</tr>
<tr>
<td>&amp;</td>
<td>And logical operator. Returns 1 if true, 0 if false.</td>
<td>x &amp; y</td>
</tr>
<tr>
<td>*</td>
<td>Multiplication operator.</td>
<td>x * y</td>
</tr>
<tr>
<td>/</td>
<td>Division operator.</td>
<td>x / y</td>
</tr>
<tr>
<td>^</td>
<td>Calculates x raised to the power of y.</td>
<td>x ^ y</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Or logical operator. Returns 1 if true, 0 if false.</td>
</tr>
<tr>
<td>+</td>
<td>Addition operator.</td>
<td>x + y</td>
</tr>
<tr>
<td>&lt;</td>
<td>Lesser than logical operator. Returns 1 if true, 0 if false.</td>
<td>x &lt; y</td>
</tr>
<tr>
<td>&lt;=</td>
<td>Lesser than or equal logical operator. Returns 1 if true, 0 if false.</td>
<td>x &lt;= y</td>
</tr>
<tr>
<td>==</td>
<td>Equal logical operator. Returns 1 if true, 0 if false.</td>
<td>x == y</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than logical operator. Returns 1 if true, 0 if false.</td>
<td>x &gt; y</td>
</tr>
<tr>
<td>&gt;=</td>
<td>Greater than or equal logical operator. Returns 1 if true, 0 if false.</td>
<td>x &gt;= y</td>
</tr>
</tbody>
</table>

**Table 37 - Calculation Operators for Alias Scaling**

Alias scaling calculations may use any of the functions listed in Table 38.

<table>
<thead>
<tr>
<th>Construct</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs</td>
<td>Absolute value.</td>
<td>abs(x)</td>
</tr>
<tr>
<td>acos</td>
<td>Arccosine</td>
<td>acos(x)</td>
</tr>
<tr>
<td>asin</td>
<td>Arcsine</td>
<td>asin(x)</td>
</tr>
<tr>
<td>atan</td>
<td>Arctangent</td>
<td>atan(x)</td>
</tr>
<tr>
<td>avg</td>
<td>Returns the average of a set of values.</td>
<td>avg(v1,v2,v3,...)</td>
</tr>
<tr>
<td>bin</td>
<td>Converts a binary number to a decimal number.</td>
<td>bin(binNumber)</td>
</tr>
<tr>
<td>ceil</td>
<td>Ceiling.</td>
<td>ceil(x)</td>
</tr>
<tr>
<td>cos</td>
<td>Cosine.</td>
<td>cos(x)</td>
</tr>
<tr>
<td>cosh</td>
<td>Hyperbolic cosine.</td>
<td>cosh(x)</td>
</tr>
<tr>
<td>Construct</td>
<td>Description</td>
<td>Examples</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>derivate</td>
<td>Differentiate the expression with respect to one variable at the specified point.</td>
<td>derivate(expression, variable, point)</td>
</tr>
<tr>
<td>fact</td>
<td>Returns the factorial of x: x*(x-1)<em>(x-2)</em>...(x-x+1).</td>
<td>fact(x)</td>
</tr>
<tr>
<td>floor</td>
<td>Floor.</td>
<td>floor(x)</td>
</tr>
<tr>
<td>hex</td>
<td>Converts an hexadecimal number to a decimal number.</td>
<td>hex(hexNumber)</td>
</tr>
<tr>
<td>if</td>
<td>If the condition is true, returns val1 else returns val2.</td>
<td>if(condition, val1, val2)</td>
</tr>
<tr>
<td>isNaN</td>
<td>Returns 1 if the number is a NaN value</td>
<td>isNaN(value)</td>
</tr>
<tr>
<td>log</td>
<td>Natural logarithm.</td>
<td>log(x)</td>
</tr>
<tr>
<td>log10</td>
<td>Base-10 logarithm</td>
<td>log10(x)</td>
</tr>
<tr>
<td>max</td>
<td>Returns larger of a set of values.</td>
<td>max(v1,v2,v3,...)</td>
</tr>
<tr>
<td>max</td>
<td>Returns larger of two values.</td>
<td>max(x,y)</td>
</tr>
<tr>
<td>max</td>
<td>Returns larger of three values.</td>
<td>max(x,y,z)</td>
</tr>
<tr>
<td>min</td>
<td>Returns smaller of a set of values.</td>
<td>min(v1,v2,v3,...)</td>
</tr>
<tr>
<td>min</td>
<td>Returns smaller of two values.</td>
<td>min(x,y)</td>
</tr>
<tr>
<td>min</td>
<td>Returns smaller of three values.</td>
<td>min(x,y,z)</td>
</tr>
<tr>
<td>rand</td>
<td>Random value between 0 and 1.</td>
<td>rand()</td>
</tr>
<tr>
<td>rand</td>
<td>Random value between min and max.</td>
<td>rand(min, max)</td>
</tr>
<tr>
<td>round</td>
<td>Round the fractional part of a number.</td>
<td>round(x)</td>
</tr>
<tr>
<td>sin</td>
<td>Sine.</td>
<td>sin(x)</td>
</tr>
<tr>
<td>sinh</td>
<td>Hyperbolic sine.</td>
<td>sinh(x)</td>
</tr>
<tr>
<td>solve</td>
<td>Finds the variable's value that yields the desired result using the Newton's numerical approximation method.</td>
<td>solve(expression, variable, result, [v0=0], [tol=0.01],[maxIter=100])</td>
</tr>
<tr>
<td>sqrt</td>
<td>Square root.</td>
<td>sqrt(x)</td>
</tr>
<tr>
<td>sum</td>
<td>Returns the sum of a set of values.</td>
<td>sum(v1,v2,v3,...)</td>
</tr>
<tr>
<td>tan</td>
<td>Tangent.</td>
<td>tan(x)</td>
</tr>
<tr>
<td>tanh</td>
<td>Hyperbolic tangent.</td>
<td>tanh(x)</td>
</tr>
<tr>
<td>trapezoid</td>
<td>Compute a numerical approximation to the integral between a and b.</td>
<td>trapezoid(expression, variable, a, b, [step=0.1])</td>
</tr>
</tbody>
</table>

Table 38 - Calculation Functions for Alias Scaling
CSV File Format

The alias import/export file contains lines of comma-separated values. Values containing commas or spaces are enclosed in double-quotation marks (" "). Double-quotation marks occurring inside quoted values are escaped with an extra double-quotation mark. Lines beginning with a hash mark (#) are ignored (used for comments). Each line contains the fields listed in Table 39.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Alias Group</strong></td>
<td>Name of the alias group folder where the alias belongs. Periods in the name indicate subfolders below the root (e.g., North.FIC101 = alias group North under the Alias Configuration root and alias group FIC101 under that).</td>
</tr>
<tr>
<td><strong>Alias Name</strong></td>
<td>Name of the alias. Full alias path name composed of the alias group path, a period, and the alias name (e.g., North.FIC101.CV for an alias named CV).</td>
</tr>
<tr>
<td><strong>Item Path</strong></td>
<td>Fully qualified item ID for the OPC item to which the alias refers.</td>
</tr>
<tr>
<td><strong>Data Type</strong></td>
<td>Decimal number indicating the data type for the alias.</td>
</tr>
<tr>
<td><strong>Read-only</strong></td>
<td>Specifies whether the alias is read-only or read-write. 0 = read-write 1 = read-only</td>
</tr>
<tr>
<td><strong>Poll Always</strong></td>
<td>Specifies whether the alias is polled continuously or not. 0 = only poll as requested by an OPC client (normal) 1 = poll continuously at the specified update rate</td>
</tr>
<tr>
<td><strong>Update Rate</strong></td>
<td>Update rate (milliseconds) to use with the Poll Always option.</td>
</tr>
<tr>
<td><strong>Scaling</strong></td>
<td>Scaling type for the alias. 0 = none 1 = linear 2 = square root 3 = gain/offset 4 = expression 5 = calculation</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>High Raw</strong></td>
<td>Raw value range (double-precision real).</td>
</tr>
<tr>
<td><strong>Low Raw</strong></td>
<td></td>
</tr>
<tr>
<td><strong>High Scaled</strong></td>
<td>Scaled value range (double-precision real).</td>
</tr>
<tr>
<td><strong>Low Scaled</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Clamp</strong></td>
<td>Clamp options. 0 = none 1 = clamp low value 2 = clamp high value 3 = clamp both high and low values</td>
</tr>
</tbody>
</table>

Table 39 - File Import/Export Field Descriptions

When the scaling field specifies linear (1) or square root (2) scaling, the line contains the additional fields listed in Table 40.
When the scaling field specifies gain/offset (3) scaling, the line contains the additional fields listed in Table 41.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain</td>
<td>Scaling factor (double-precision real).</td>
</tr>
<tr>
<td>Offset</td>
<td>Scaling offset (double-precision real).</td>
</tr>
</tbody>
</table>

When the scaling field specifies expression (4) scaling, the line contains the additional fields listed in Table 42.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Expression</td>
<td>Simple formula applied to the value read from the OPC item.</td>
</tr>
<tr>
<td>Output Expression</td>
<td>Simple formula applied to values written to the OPC item. The output formula should be the reciprocal of the input formula.</td>
</tr>
</tbody>
</table>

When the scaling field specifies calculation (5) scaling, the line contains the additional fields listed in Table 43.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input Calculation</td>
<td>Calculation applied to the value read from the OPC item.</td>
</tr>
</tbody>
</table>

**Scaling Algorithms**

For each type of scaling, a different algorithm (Table 44) is applied to values read from the OPC item. A reverse algorithm is applied to any values written to the OPC item.

<table>
<thead>
<tr>
<th>Scaling</th>
<th>Algorithm/Example</th>
<th>Reverse Algorithm/Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linear</td>
<td>[(x - \text{Raw}<em>{\text{Low}}) \cdot \frac{\text{Scaled}</em>{\text{High}} - \text{Scaled}<em>{\text{Low}}}{\text{Raw}</em>{\text{High}} - \text{Raw}<em>{\text{Low}}} + \text{Scaled}</em>{\text{Low}}]</td>
<td>[(x - \text{Scaled}<em>{\text{Low}}) \cdot \frac{\text{Raw}</em>{\text{High}} - \text{Raw}<em>{\text{Low}}}{\text{Scaled}</em>{\text{High}} - \text{Scaled}<em>{\text{Low}}} + \text{Raw}</em>{\text{Low}}]</td>
</tr>
<tr>
<td>Square Root</td>
<td>[\sqrt{x - \text{Raw}<em>{\text{Low}}} \cdot \frac{\text{Scaled}</em>{\text{High}} - \text{Scaled}<em>{\text{Low}}}{\text{Raw}</em>{\text{High}} - \text{Raw}<em>{\text{Low}}} + \text{Scaled}</em>{\text{Low}}]</td>
<td>[(x - \text{Scaled}<em>{\text{Low}}) \cdot \frac{\text{Raw}</em>{\text{High}} - \text{Raw}<em>{\text{Low}}}{(\text{Scaled}</em>{\text{High}} - \text{Scaled}<em>{\text{Low}})^2} + \text{Raw}</em>{\text{Low}}]</td>
</tr>
<tr>
<td>Gain/Offset</td>
<td>Gain \cdot x + Offset</td>
<td>x - Offset \over Gain</td>
</tr>
<tr>
<td>Expression</td>
<td>SQRT(INPUT) + 5</td>
<td>(OUTPUT - 5) \cdot (OUTPUT - 5)</td>
</tr>
<tr>
<td>Calculation</td>
<td>\text{round}([\text{Random.Real4}])</td>
<td>N/A</td>
</tr>
</tbody>
</table>
# Appendix C – Standard Data Types

The Standard data types and their descriptions are listed in Table 45.

<table>
<thead>
<tr>
<th>Hex</th>
<th>Dec</th>
<th>Data Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>0</td>
<td>VT_EMPTY</td>
<td>Default/Empty (nothing)</td>
</tr>
<tr>
<td>0002</td>
<td>2</td>
<td>VT_I2</td>
<td>2-byte signed integer</td>
</tr>
<tr>
<td>0003</td>
<td>3</td>
<td>VT_I4</td>
<td>4-byte signed integer</td>
</tr>
<tr>
<td>0004</td>
<td>4</td>
<td>VT_R4</td>
<td>4-byte (single-precision) real</td>
</tr>
<tr>
<td>0005</td>
<td>5</td>
<td>VT_R8</td>
<td>8-byte (double-precision) real</td>
</tr>
<tr>
<td>0006</td>
<td>6</td>
<td>VT_CY</td>
<td>Currency</td>
</tr>
<tr>
<td>0007</td>
<td>7</td>
<td>VT_DATE</td>
<td>Date</td>
</tr>
<tr>
<td>0008</td>
<td>8</td>
<td>VT_BSTR</td>
<td>Text (UNICODE)</td>
</tr>
<tr>
<td>000A</td>
<td>10</td>
<td>VT_ERROR</td>
<td>Error code</td>
</tr>
<tr>
<td>000B</td>
<td>11</td>
<td>VT_BOOL</td>
<td>Boolean (TRUE = -1, FALSE = 0)</td>
</tr>
<tr>
<td>0011</td>
<td>16</td>
<td>VT_I1</td>
<td>1-byte signed integer</td>
</tr>
<tr>
<td>0012</td>
<td>17</td>
<td>VT_UI1</td>
<td>1-byte unsigned integer</td>
</tr>
<tr>
<td>0013</td>
<td>18</td>
<td>VT_UI2</td>
<td>2-byte unsigned integer</td>
</tr>
<tr>
<td>0014</td>
<td>19</td>
<td>VT_UI4</td>
<td>4-byte unsigned integer</td>
</tr>
<tr>
<td>2002</td>
<td>8194</td>
<td>VT_ARRAY</td>
<td>VT_I2</td>
</tr>
<tr>
<td>2003</td>
<td>8195</td>
<td>VT_ARRAY</td>
<td>VT_I4</td>
</tr>
<tr>
<td>2004</td>
<td>8196</td>
<td>VT_ARRAY</td>
<td>VT_R4</td>
</tr>
<tr>
<td>2005</td>
<td>8197</td>
<td>VT_ARRAY</td>
<td>VT_R8</td>
</tr>
<tr>
<td>2006</td>
<td>8198</td>
<td>VT_ARRAY</td>
<td>VT_CY</td>
</tr>
<tr>
<td>2007</td>
<td>8199</td>
<td>VT_ARRAY</td>
<td>VT_DATE</td>
</tr>
<tr>
<td>2008</td>
<td>8200</td>
<td>VT_ARRAY</td>
<td>VT_BSTR</td>
</tr>
<tr>
<td>200A</td>
<td>8202</td>
<td>VT_ARRAY</td>
<td>VT_ERROR</td>
</tr>
<tr>
<td>200B</td>
<td>8203</td>
<td>VT_ARRAY</td>
<td>VT_BOOL</td>
</tr>
<tr>
<td>2011</td>
<td>8208</td>
<td>VT_ARRAY</td>
<td>VT_I1</td>
</tr>
<tr>
<td>2012</td>
<td>8209</td>
<td>VT_ARRAY</td>
<td>VT_UI1</td>
</tr>
<tr>
<td>2013</td>
<td>8210</td>
<td>VT_ARRAY</td>
<td>VT_UI2</td>
</tr>
<tr>
<td>2014</td>
<td>8211</td>
<td>VT_ARRAY</td>
<td>VT_UI4</td>
</tr>
</tbody>
</table>

*Table 45 - Standard Data Types*
Appendix D – Microsoft Excel as a DDE Client

Microsoft Excel can act as both DDE client and DDE server. When using Excel as the client, DDE items can be bound to specific cells in a spreadsheet, creating a read-only “hot link” to the DDE items. Using Visual Basic, Excel can also be used to transmit (write) the data contained in a specific cell of a spreadsheet to a DDE server.

DDE Read

To perform a DDE Read using Excel, simply enter a DDE Item as a formula in some spreadsheet cell:

\[ =\text{SERVICE}\mid \text{TOPIC}\mid \text{NAME} \]

Excel will initiate a DDE Advise loop, or “hot link”, to the topic and item within the service. The DDE Management system (in this case, Windows) will forward any update sent by the DDE service, to the appropriate DDE client (in this case, Microsoft Excel). The DDE service is responsible for update rate/behaviour.

To disable a specific hotlink in Excel, use the Links menu option under the Edit menu.

Special Characters in Excel

Excel reserves the use of specific characters for use in any cell. If a SERVICE, TOPIC, or NAME contains any special characters, surround the specific field with single quotation characters (‘ ‘):

\[ =\text{SERVICE}\mid \text{TOPIC}'\text{NAME}' \]
\[ =\text{SERVICE}'\text{TOPIC}'\text{NAME}' \]
\[ =\text{SERVICE}'\text{TOPIC}'\text{NAME} \]

To include single quotation characters in the name, enter two simultaneous single quotation characters:

\[ =\text{matrikon_opc_simulation}_1'\text{Power.GeneratorAnswer}'\text{Value}'1000' \]

DDE Write

To perform any DDE command other than requests (read) or advise (hot link), a Visual Basic (VB) function must be used. Most DDE commands are available by using the application object. For example, the following function will poke (write) the contents of column 1, row 1 to an item in the OPC Simulation server:

```vbscript
Sub WriteToDDE()
    ' open a DDE channel. Field 1 = SERVICE, Field 2 = TOPIC
    'channel = DDEInitiate("matrikon_opc_simulation", "Bucket Brigade.Real4")

    ' poke to the Item 1000\, the value of cell A1
    DDEPoke channel, "1000\", Worksheets("Sheet1").Range("A1")

    ' close the channel
    DDETerminate channel
End Sub
```
**Net DDE**

Since DDE commands are routed by the operating system, it is not possible to establish a DDE session between two computers unless some transport mechanism is used. This is usually supplied as a plug-in component of the operating system. In the Windows Environment, the NetDDE Windows Service allows DDE communication between two computers.

NetDDE must first be configured using the DDEShare application (`DDEShare.exe`) as shown in Figure 40. Each SERVICE and TOPIC pair, or "NetDDE Share", that is to be available through NetDDE must be assigned a unique name.

![DDE Share](image)
Appendix E – Security

Introduction
The OPC Framework has implemented the OPC Security Customer Interface version 1.0 of the specification. Both the \textit{IOPCSecurityNT} and \textit{IOPCSecurityPrivate} interfaces are fully supported (there are no optional pieces).

\textit{IOPCSecurityNT} describes how NT authentication is used in OPC Security. \textit{IOPCSecurityPrivate} describes how proprietary user credentials are used in OPC Security. The OPC Security specification defines how user credentials are passed from client to server, but very little else. The type of functionality in an OPC server that is controlled by OPC Security is vendor-determined.

Appendix Structure
This appendix is structured as follows:

- \textbf{Introduction} – this introductory section.
- \textbf{OPC Security Implementation} – description of user access dependencies.
- \textbf{MatrikonOPC Tag Security Configuration Utility} – describes the utility that is used to configure security for MatrikonOPC servers.
- \textbf{Security Details} – describes how permissions are applied, how security settings are stored, and other important details.

OPC Security Implementation
Whether a user has access or not will depend on:

1. \textbf{Identity} – the user behind the OPC client’s actions.
2. \textbf{Location} – the OPC item ID or hierarchy path being accessed.
3. \textbf{Type} – the type of functionality the user is trying to perform.

Identity
Using the \textit{IOPCSecurityNT} interface for OPC Security, the identity of the OPC client is the domain user that is running the OPC client and connecting to the OPC server. The OPC Framework will attempt to impersonate the client that is connected to the server, and use the name from those credentials for access control. This method does not require any implementation of OPC Security by the OPC client, since no interface calls are necessary.

Using the \textit{IOPCSecurityPrivate} interface for OPC Security, the OPC client must make a call to the OPC server to log on with a user name and password. In this scenario, the OPC client must implement and follow the OPC Security specification in terms of following the calls necessary to provide credentials. The credentials provided through the private interface override those provided from the NT interface. The OPC client may choose to log off, at which point the NT credentials are used until the log on call is made again.

Location
Some of the interface calls made from an OPC client to an OPC server require the client to provide an OPC item ID. The OPC Framework will take the OPC item ID provided, and determine whether access to that location is allowed or not. A particular server installation may want to control access to a particular device or branch in the hierarchy, and is able to do so by setting permissions for a partial item ID or path.
Other interface calls do not provide an ID, but may depend on the state of the server with respect to previous calls. OPC Browsing (DA 2.0) is an example of this. In this case, the full path up to that particular location is used for determining access rights.

**Type**

There are four types of interface functionality in the OPC Framework (specifically the OPC Outer Layer) that are controlled using OPC Security:

1. Browsing
2. Adding items
3. Reading
4. Writing

Browsing is the least intrusive, followed by adding items, reading values from the items, and finally writing to the items being the most intrusive. There are multiple interfaces, and functions within those interfaces, that can be used to perform the types of functionality listed above. Thus, security control has been added to each possible entry. For example, read control has been added to group subscriptions call-backs as well as synchronous reads and asynchronous reads – denying read control would disable reads for the possible types.

A location that is being accessed by an OPC client may have different permissions for the different types of access. For example, one particular item may be browseable, added, and read, but the writing permissions might be restricted so that the user cannot interfere with the operation of the end device.

**Note:** Of the four functionality types listed above, three of them make use of the full OPC item ID when an interface call is made from the client to the server: Adding Items, Reading, or Writing. When browsing, only a partial path leading to an OPC item may be known at any location in the browsing hierarchy.

**MatrikonOPC Tag Security Configuration Utility**

The tag security settings for MatrikonOPC servers are configured and managed via the MatrikonOPC Tag Security Configuration Utility, a tool that is installed with the server. This utility allows users to define, per MatrikonOPC server, the following:

- Who has permission
- Which tags/locations they have permissions for
- The type of permissions for those locations

Security settings configured using this utility are read by the OPC Framework and populated in memory upon server start-up, and are monitored for changes.

**Note:** In order for the MatrikonOPC Tag Security Configuration Utility to work properly, the windows user running the utility must have Administrator rights to the computer.

The MatrikonOPC Tag Security Configuration Utility is a component of an OPC server installation, and is installed in the following location:

```
C:\Program Files\Common Files\MatrikonOPC\Common\ACLConfig.exe
```

The MatrikonOPC Tag Security Configuration Utility can be run either directly from its installed location, or from a shortcut found in the Start Menu. If the utility is run from the installed location, then the user must select the OPC server for which security will be configured. If the MatrikonOPC Tag Security Configuration Utility is run from the shortcut, then it will configure security for the OPC server to which the shortcut belongs.
To run the MatrikonOPC Tag Security Configuration Utility from its shortcut:

1. Click on the Windows **Start** button.
2. Select **Programs -> MatrikonOPC -> <OPC Server Name> ->Tag Security**.

![Figure 41 - Start Menu Navigation](image)

After the MatrikonOPC Tag Security Configuration Utility is run:

1. A window appears asking for a password to be entered. This protects the security settings and prevents unauthorized individuals from accessing these settings. For servers that required a security password to be entered during their installation, the **Enter server password** window (Figure 42) appears.

![Figure 42 - Enter Server Password Window](image)

2. Enter the password that was created during the installation of the OPC server.
3. Click on the **OK** button.
   
   **Note:** During installation, if the user did not enter a password for encryption, then steps 1 through 3 are skipped.

4. The **MatrikonOPC Tag Security Configuration Utility** screen (Figure 43) appears.
The **MatrikonOPC Tag Security Configuration Utility** screen displays the name of the OPC server that is being configured for tag security. In Figure 43 above, the **Utility** screen shows that the **MatrikonOPC Server for Simulation and Testing** tag security is being configured.

The left-hand side of the **Utility** screen shows a column of action icons that can be clicked upon. These actions are further described later in this appendix. Some actions may not be applicable, depending on the context in which they are used, and are identified by greyed-out icons.

In the center of the **Utility** screen there are descriptions for each of the actions that can be performed. The appearance of these descriptions can be toggled at any time by clicking on the **Hide Help/Show Help** link that exists in the bottom-right corner of the **Utility** screen. When the **Help** screen is hidden, a list of users and groups that have been added appears (Figure 44). By default, there is always a user named **Everyone** in the **Users & Groups** list. This user defines the permissions used for other NT users that are not configured.
Note: After any action is performed, the changes made do not take effect until either the OK or Apply button has been selected. Clicking on the OK button saves the changes and closes the Utility screen. Clicking on the Apply button saves the changes and keeps the Utility screen open. Clicking on the Cancel button or the X button on the top-right of the screen, discards any changes made.

Add User

There are two types of users for which security can be configured: NT Users and Private Users. Adding a user to the configuration will allow permissions to be defined for that user. For NT users, the IOPCSecurityNT interface is used, and for Private users, the IOPCSecurityPrivate interface is used.

NT User

To add an NT user:

1. From the MatrikonOPC Tag Security Configuration Utility main screen, click on the Add User button.
2. The **Add User** window (Figure 45) appears. The **NT User** option button is selected by default. This will allow the addition of a user from a Windows NT Domain.

![Add User Window (NT)](image)

3. By default, the local machine name appears in the **From this Location** field. To browse to a different location, click the **Locations** button.

4. The **User** field can be entered manually. Clicking on the **Check Name** button performs validation on the entered user. The user names are the same as the Windows NT domain names used on the network. To avoid manually entering a user, click on the **Search** button, and select a user from the displayed list of users.

5. To add the selected user, click on the **OK** button. The user is then added to the list of users and/or groups currently defined (refer to Figure 46 for a sample list of defined users and groups).

6. The **Edit <Username>** window (Figure 51) appears. Follow the instructions in the **Edit User** section for adding permissions.
Private User

Private users have names and passwords associated with them, custom to the OPC client application, which must implement the OPC Security Private interface for this section to be meaningful. Private users exist only in the OPC server. They are not created in any NT domains.

To add a Private user:

1. From the MatrikonOPC Tag Security Configuration Utility main screen, click on the Add User button.
2. The Add User window (Figure 45) appears.
3. Select the Private User option button (Figure 47).
4. In the **Username** field, enter a user name.

5. In the **Password** field, enter a password.

6. In the **Password Confirmation** field, re-enter the new password.

7. Click **OK** to create the Private user. It will be added to the list of users and/or groups currently defined (refer to Figure 46 for a sample list of defined users and groups).

   **Note:** The user name cannot be added if there is already a configured User or Group with that same name.

### Add Group

Groups are used to group users together so that they can share common permissions. Groups are not necessary to use OPC Security. However, they are convenient when you need to apply common permissions to multiple users. A group must contain at least one user, and any combination of users can be grouped together.

**Note:** A user can exist in multiple groups, but if two or more of the groups have the same configured path (refer to the **Edit User** section), and each group defines a permission (Allow/Deny) for the type of access, then the group whose name alphabetically comes first is used.

There are two types of groups for which security can be configured: **NT Groups** and **Private Groups**.

### NT Group

**To add an NT group:**

1. From the **MatrikonOPC Tag Security Configuration Utility** main screen, click on the **Add Group** button.
2. The **Add Group** window (Figure 48) appears. The **NT Group** option button is selected by default. This will allow the addition of an NT group from a Windows NT Domain.

![Add Group Window (NT)](image)

3. By default, the local machine name appears in the **From this Location** field. To browse to a different location, click the **Locations** button.

4. The **Group** field can be entered manually. Clicking on the **Check Group** button performs validation on the entered group. The group names are the same as the Windows NT domain group names used on the network. To avoid manually entering a group, click on the **Search** button, and select a group from the displayed list of groups.

5. To add the selected group, click on the **OK** button. The group is then added to the list of users and/or groups currently defined (refer to Figure 46 for a sample list of defined users and groups).

6. The **Edit <Groupname>** window (Figure 58) appears (for NT Groups, there is only the **Permissions** tab). Follow the instructions in the **Edit Group** section for adding permissions.

**Private Group**

**To add a Private Group:**

1. From the **MatrikonOPC Tag Security Configuration Utility** main screen, click on the **Add Group** button.

2. The **Add Group** window (Figure 48) appears.

3. Select the **Private Group** option button (Figure 49).
4. Enter a name for the group to be created. The group is private and will only exist in the OPC server. The group cannot be created if there is already a configured user or group with that same name.

5. Click on the OK button to create the group. It will be added to the list of users and/or groups currently defined (refer to Figure 46 for a sample list of defined users and groups).

6. The Edit <Groupname> window (Figure 58) appears. Follow the instructions in the Edit Group section for adding permissions.

**Duplicate**

Another way to create a new user or group is to duplicate an existing one.

**To create a new user or group via duplication:**

1. From the MatrikonOPC Tag Security Configuration Utility main screen, right-click your mouse on the user or group you wish to duplicate.

2. From the displayed menu, select **Duplicate**.

3. The Enter New Name window (Figure 50) appears.
4. Enter a name for the new user or group to be created.
5. Click on the OK button. There must not already be a configured user or group with that same name. The new user or group will then appear in the list, and will contain the same properties as the duplicated parent (i.e., original) user or group.

**Edit**

Once the desired users and/or groups are defined, they must be edited to configure their respective permissions.

**Note:** Permissions can also be defined for the user *Everyone*, which is defined as the default user. For every NT user not configured in the MatrikonOPC Tag Security Configuration Utility, the user *Everyone* is used for determining security permissions.

Permissions for allowing/denying browsing, adding items, reading items, and writing items can be configured. Permissions are defined for users and groups for a particular location in the server’s address space hierarchy. A location can either be a tag (i.e., OPC Item ID) or a path leading up to an item.

**Edit User**

**To edit a user:**

1. From the MatrikonOPC Tag Security Configuration Utility main screen, either:
   - Double-click your mouse on the user you wish to edit, or
   - Right-click your mouse on the required user and select **Edit User** from the displayed menu, or
   - Click your mouse on the required user, and then select the **Edit** button.

2. The **Edit <Username>** window (Figure 51) appears.

**Notes:**

- In this example, the user being edited is **User1** so the window’s title reads **Edit User1**.
- There are two tabs on this window: **Permissions** and **General**. The **General** tab only appears for private users.
Permissions

On the Permissions tab, the permissions associated with this user relating to browsing, adding, reading, and writing for any specific paths or OPC items are configured. The Configured Paths screen section lists the paths and/or OPC items for which permissions are defined. The Permissions screen section indicates those permissions with option buttons, which can be set to Allow, Deny, or Unspecified. Selecting Unspecified directs the OPC Framework to look for the permission higher up in the hierarchy.

From the Permissions tab, when the Add button is selected, the Add Permission screen is displayed. In the Server Address Space screen section, folders and items are shown as nodes are selected and expanded.

Red folders indicate a null branch. This means that the item names below this branch do not contain the branch name, so permissions set on the branch will not reflect on Add, Write, and Read permissions for the items below the branch. To properly set permissions on the items below the branch, they have to be set on the items themselves.

Figure 52 provides an example of a null branch and items below it, all of which are outlined in black.
When browsing, using the example in the diagram above, **Simulation Items** is a null branch (identified by the red folder), **Saw-toothed Waves** is a non-null branch, and **Int1** is an item.

Setting permissions on the **Simulation Items** branch does not affect **Read**, **Write**, and **Add** permissions for the **Saw-toothed Waves** branch of the **Int1** item below that. This is because when adding the **Int1** item, the item ID of the **Int1** item is actually **Saw-toothed Waves.Int1** and not **Simulation Items\Saw-toothed Waves.Int1**.

Setting **Read**, **Write**, and **Add** permissions for the **Saw-toothed Waves** branch will affect the items below as **Saw-toothed Waves** is part of the item ID of the **Int1** item (**Saw-toothed Waves.Int1**), and therefore the **Saw-toothed Waves** folder does not appear as a red folder like the **Simulation Items** folder does.

**Note:** User permissions override group permissions. For example, if a defined group is denied writing privileges to an OPC item, **Random.Int4**, while a defined user (a member of that group) is allowed writing privilege to Random items (**Random.<itemID>**), then the user permissions would take precedence for that OPC item (even though the permissions relating to the group are a better match for the OPC item, **Random.Int4**).

**To edit a user’s permissions:**

1. Click on the **Add** button to begin configuring permissions for the current user.
2. The **Add User Permission** window (Figure 53) appears. This window allows you to browse the OPC server address space to find either a path in the hierarchy, or a particular OPC item.
3. Expand on the server address space’s root node and continue to browse to the desired path in the hierarchy, or the desired OPC item.

   **Note:** Branches (i.e., folders) that are red in colour (see Figure 54) are not part of an item’s path, but rather are used for browsing organization. Configuring permissions for adding, reading, and writing will not affect items below it. For more information, refer to **Permissions**.
4. Click on the OK button.

5. The selected path or item will be listed in the **Configured Paths** screen section of the **Edit User** window. Permissions can now be assigned, as in the example depicted in Figure 55.

   **Note:** In this example, **User1** is allowed to browse the **Random** path of the OPC server’s address space. Adding privileges are denied, and Reading and Writing privileges are unspecified.
On the General tab (Figure 56) of the Edit <Username> window, the name and password of the user can be changed.

**To edit a user’s name:**

1. Enter a new name in the Name field.
2. Click on the OK button.
To change the user’s password:

1. Click on the **Reset Password** button. The **Reset Password** window (Figure 57) appears.

2. Enter the new password in the **Password** field.
3. Re-enter the password in the **Password Confirmation** field.
4. Click on the **OK** button.
Edit Group

To edit a group:

1. From the MatrikonOPC Tag Security Configuration Utility main screen, either:
   - Double-click your mouse on the group you wish to edit, or
   - Right-click your mouse on the required group and select Edit Group from the displayed menu, or
   - Click your mouse on the required group and then select the Edit button.

2. The Edit <Groupname> window (Figure 58) appears.

Notes:

- In this example, the group being edited is Group1 so the window’s title reads Edit Group1.
- For Private Groups, there are three tabs on this window: Permissions, General, and Members. For NT Groups, there is only the Permissions tab.

![Edit Group1 window](image)

Figure 58 - Edit <Groupname> Window (Permissions Tab)

On the Permissions tab, the permissions associated with this group relating to browsing, adding, reading, and writing for any specific paths or OPC items are configured. Refer to the Edit User section regarding configuration on the Permissions tab. Group and user permissions are configured in the same way.
On the **General** tab (Figure 59) of the **Edit <Groupname>** window, the name of the group can be changed.

**To edit a group’s name:**

1. Enter a new name in the **Name** field.
2. Click on the **OK** button.

![Figure 59 - Edit <Groupname> Window (General Tab)](image)

On the **Members** tab (Figure 60), the users that are part of the current group are defined. By default, the **Group Members** screen section is empty. In Figure 60, **User1** has been added to **Group1**.

![User1 added to Group1](image)
To add one or more members to the group:

1. Click on the Add button. The Add Existing User window (Figure 61) appears.
2. The **Members** screen section lists all the defined users from which you may choose. Select one or more desired users to become members of the group.

3. Click on the **OK** button. The selected user or users appear in the **Group Members** screen section on the **Members** tab (Figure 60).

**To remove a user from the group:**

1. Select that user in the **Group Members** screen section.
2. Click on the **Remove** button.

**Notes:**

- If a user name and a group name (to which the user belongs) have permissions defined for the same location, the user name will be used. If a user belongs to two groups that have permissions defined for the same location, the group that is alphabetically first will be used.

- The exact location (full item ID for reading, writing, and adding, or the full path for browsing) is always looked for first when determining the permission for a particular user. If the exact location is not found, or is found but does not contain a defined permission, then the closest match in location is looked at next, and so on. The root location (i.e., empty string) will always match, and is used if no partial location match is made.

**Delete**

**To delete a previously added user or group:**

1. From the **MatrikonOPC Tag Security Configuration Utility** main screen, either:
   - Select the required user or group from the list and click on the **Delete** button (Figure 46), or
For a group, right-click your mouse on the required group and select **Delete Group** from the displayed menu, or
For a user, right-click your mouse on the required user and select **Delete User** from the displayed menu

Change Password

To change the security password for the OPC server:

1. From the MatrikonOPC Security Configuration Utility main screen, click on the **Change Password** button (Figure 43).
2. The **Change Password** window (Figure 62) appears.
3. Enter the old password for the current OPC server.
4. Enter and confirm the desired new password.
5. Click on the **OK** button.

**Note:** Changes are applied in the Utility main window by clicking on either the **OK** or **Apply** button.

Examples

This section contains examples of tag security settings made via the MatrikonOPC Tag Security Configuration Utility, and the impact of these settings.

Default

The default tag security configuration provided is quite simplistic as is shown in Table 46:

<table>
<thead>
<tr>
<th>User/Group</th>
<th>Configured Paths</th>
<th>Browse</th>
<th>Add</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>\</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
</tr>
</tbody>
</table>

**Table 46 - Default Tag Security**

As no users or groups are defined, any NT user connecting to the OPC server will use the **Everyone** default user for permissions. Only the root level location is defined under the **Configured Paths** list, which gives full permissions to the entire OPC server. An administrator will want to change these default settings for the OPC server to provide more security on its tags.
Example 1

Table 47 contains a possible tag security configuration enforces complete restricted access except for the NT user *DOMAIN\Admin*:

<table>
<thead>
<tr>
<th>User/Group</th>
<th>Configured Paths</th>
<th>Browse</th>
<th>Add</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>\</td>
<td>Deny</td>
<td>Deny</td>
<td>Deny</td>
<td>Deny</td>
</tr>
<tr>
<td>DOMAIN\Admin</td>
<td>\</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
</tr>
</tbody>
</table>

Table 47 - Example 1

At this point, more users can be added which belong to a more restricted group. This group may be denied write capability or restricted to certain areas in the server hierarchy.

Example 2

Following is an example of a tag security configuration for the MatrikonOPC Server for Simulation and Testing, with sample use-cases. Table 48 lists all defined users and groups and their associated permissions. Table 49 indicates which users are members of the defined groups. *Unspec.* permission indicates *Unspecified*. Groups in this example are Private Groups.

<table>
<thead>
<tr>
<th>User/Group</th>
<th>Configured Paths</th>
<th>Browse</th>
<th>Add</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td>\</td>
<td>Allow</td>
<td>Deny</td>
<td>Deny</td>
<td>Deny</td>
</tr>
<tr>
<td>DOMAIN\john.doe</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOMAIN\fred.stone</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOMAIN\sally.simpson</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOMAIN\the.admin</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supervisor</td>
<td>\</td>
<td>Deny</td>
<td>Allow</td>
<td>Allow</td>
<td>Deny</td>
</tr>
<tr>
<td>Restricted (group)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Common (group)</td>
<td>\</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
<td>Deny</td>
</tr>
<tr>
<td>Common (group)</td>
<td>Triangle Waves</td>
<td>Deny</td>
<td>Deny</td>
<td>Deny</td>
<td>Deny</td>
</tr>
<tr>
<td>Admin (group)</td>
<td>\</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
</tr>
</tbody>
</table>

Table 48 - Example 2: Permissions

<table>
<thead>
<tr>
<th>User/Group</th>
<th>Configured Paths</th>
</tr>
</thead>
<tbody>
<tr>
<td>Restricted</td>
<td>DOMAIN\john.doe</td>
</tr>
<tr>
<td>Common</td>
<td>DOMAIN\fred.stone, DOMAIN\sally.simpson</td>
</tr>
<tr>
<td>Admin</td>
<td>DOMAIN\the.admin</td>
</tr>
</tbody>
</table>

Table 49 - Example 2: Groups and Members

Tip 1

Adding a user name and not defining any permissions for that user name (or any group it belongs to), will completely restrict their access to information in the OPC server.
Case 1

User `DOMAIN\john.doe` connects. The user is unable to perform any function at any level, since no permissions have been defined for this user name or the Restricted group to which it belongs.

Tip 2

Use the root location to define permissions for locations that have not been defined. Use the default user to define permissions for users that are not listed.

Case 2

User `DOMAIN\no.name` connects. This name is not defined so the default user permissions are used. At the root level location, the default user can browse but no more. The only other location where permissions are defined for the default user is Configured Aliases – here browsing is denied and adding, reading, and writing permissions are not defined. Thus, `DOMAIN\no.name` will be able to browse the entire server except the Configured Aliases branch and all aliases under it. Also, `DOMAIN\no.name` will not be able to do any item addition, reading, or writing. Since item addition, reading, and writing permissions were not defined for the default user for under Configured Aliases, it would use the permissions defined at the root level.

Case 3

User `DOMAIN\fred.stone` connects. This user belongs to the defined group Common. At the root level, the group Common can browse, add, and read items, but writing is denied. The only other location which defines permissions for this group is Triangle Waves. This location has denied all permissions for the Common group.

Case 4

User Supervisor connects through the private security interface and logs on. This user does not belong to any group, but its name has a root level permission which allows it to add and read items. No other locations have permissions defined. Since the user cannot browse, it will need to know the item syntax for any items it wishes to add and read.

Case 5

User `DOMAIN\the.admin` connects. This user belongs to the Admin group, which at the root level has all permissions allowed. The only other location where the Admin group has permissions defined, is the full item ID Bucket Brigade.Int4. This user is unable to write to that item. However, the root permissions for browsing, adding, and reading the item apply as they are not defined at this level.

Security Details

ACL File

The permissions that the MatrikonOPC Tag Security Configuration Utility creates are stored in a file named ACL.sec that is located in the same directory as the MatrikonOPC server executable: `C:\Program Files\Matrikon\OPC\< OPC Server Name >\`. 

ACL.sec is encrypted with 256-bit AES using the password key that was provided during installation (or changed in the security utility).

If ACL.sec is missing from its location above, then the OPC server will deny all users access to all browsing, adding, reading, and writing functionality.

Note: It is advised that this file is backed up and stored somewhere safe, once tag security configuration has been completed. In the event that this file is lost or deleted by accident, simply transfer the stored backup (if one was made) to the directory stated above. If ACL.sec becomes deleted and no backup was made, tag security will need to be re-configured.
Run-Time Tag Security Configuration

Tag security can be configured and updated while a MatrikonOPC server is running. This run-time security configuration can be controlled using the \#MonitorACLFile OPC item (found in the root branch when browsing the server).

The \#MonitorACLFile is a boolean OPC tag that has a default value of True when the server starts which indicates that the tag security permissions are monitored and applied while the server is running. By adding this item to an OPC group and writing a value of False to this item, the server no longer applies tag security configuration changes while the server is running. The server would need to be stopped and restarted for the changes to take effect.

By disabling the ability of run-time tag security configuration, a malicious user that has access to the machine cannot delete the ACL file and thus remove all user permissions for OPC security. Run-time tag security configuration can be re-enabled when changes to the tag security need to be made, and then disabled again once they have been applied.

Security should be applied to the \#MonitorACLFile tag so that unauthorized users are unable to control this ability described above.

Client Connections and Private Log On

When an OPC client connects to the server, the OPC Framework impersonates the client and determines the name of the NT user that is running the client. This client name (consisting of the domain name and the user for that domain) is what the OPC Framework uses when checking permissions set in the MatrikonOPC Tag Security Configuration Utility. If this NT user was not added in the Users & Groups list (Figure 46), then the user Everyone is used instead.

If the OPC client chooses to use the IOPCSecurityPrivate interface, it must call the Logon() function and provide a name and password. The OPC Framework will immediately look for the private user in the Users & Groups list (Figure 46). If the user is found and the password provided is correct, the Logon() result is successful and the user name provided replaces the NT user that was obtained through impersonation. If not found, the Logon() result is failure and the NT user remains as the name used for security permissions. When the OPC client calls Logoff(), the NT user becomes the name used for security permissions.

Determining Permission

Whenever a browsing, item addition, read, or write operation is performed by the OPC client, the OPC Framework will call a permission routine to determine if permission is allowed or denied. Three pieces of information are always sent to this routine call:

1. Identity
2. Location
3. Type

Identity is the user name described in the previous section – either the NT domain name, a private name, or the default user Everyone. In addition, identity includes any groups (private or NT) that the user belongs to. Location is either the full item ID or a partial path in the server hierarchy. Type is the access type: browsing, item addition, reading, or writing. Each piece of information is checked in the order listed above.

The following information details the procedure used in determining permission rights:

1. Look for a permission match with the NT domain name or private name. This step occurs only if the NT domain name or private name has been defined in the Users & Groups list.
2. If a permission match was not yet found, look for one using each group defined in the **Users & Groups** list that the NT domain name or private name belongs to. The first group that contains a permission match will be the one used. An NT domain name does not need to be defined in the **Users & Groups** list for a group it belongs to, to have a permission match. The NT domain name must be part of **Group Members** for private groups, or in the Active Directory for NT groups.

3. If a permission match was not yet found, look for a permission match using the default user **Everyone**.

The procedure used in finding a permission match for a particular identity is as follows:

1. Check whether the exact location is found in the **Configured Paths** list for the identity. If found:
   a. Check whether the permission type (**browse**, **add**, **read**, or **write**) is specified (Figure 55). If the permission type is specified for the action being performed, a match is found and the permission (either allow or deny) is used.

2. If a permission match was not found in step 1a, check whether a partial match of the location is found in the **Configured Paths** list for the identity. A partial match is always a sub-string of the given location that starts with the same characters. This represents starting from the root location and moving down the browsing hierarchy.

For example, the location **Random** is a partial match of the full item ID **Random.String**. However, **String** is not a partial match (even if it is a sub-string) because it does not match the first seven characters. The root location \ is considered a partial match for every full item ID.

For each partial match from step 2, apply step 1a. The best partial match (i.e., the one that has the most characters) that is successful in step 1a is the one whose permission is used.

**Example**

The following is an example of a tag security configuration. Table 50 lists all defined users and their associated permissions.

<table>
<thead>
<tr>
<th>User/Group</th>
<th>Configured Paths</th>
<th>Browse</th>
<th>Add</th>
<th>Read</th>
<th>Write</th>
</tr>
</thead>
<tbody>
<tr>
<td>Everyone</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DOMAIN\john.doe</td>
<td>\</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
</tr>
<tr>
<td>DOMAIN\john.doe</td>
<td>Random</td>
<td>Allow</td>
<td>Deny</td>
<td>Deny</td>
<td>Deny</td>
</tr>
<tr>
<td>DOMAIN\john.doe</td>
<td>Random.Int</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
<td>Allow</td>
</tr>
</tbody>
</table>

**Table 50 - Example 2: Permissions**

The user **DOMAIN\john.doe** wants to read the item **Random.Int4**. The permission routine would not be able to find an exact location match under the **Configured Paths** list. However, it would loop through each partial match in the Configured Paths list looking for a defined permission. The location **Random.Int** would be the closest match and the permission would be **ALLOW**.

The user **DOMAIN\john.doe** wants to read the item **Random.Real4**. The permission routine would not be able to find an exact location match under the **Configured Paths** list. However, it would loop through each partial match in the Configured Paths list looking for a defined permission. The location **Random** would be the closest match and the permission would be **DENY**.